STUDY AT A GLOBAL TOP 2% UNIVERSITY IN ONE OF THE MOST LIVEABLE CITIES IN THE WORLD

*TIMES HIGHER EDUCATION WORLD UNIVERSITY RANKINGS 2016-2017
** ECONOMIST INTELLIGENCE UNIT 2016
Adelaide is a lively, safe and friendly place to study. You can enjoy our beautiful beaches, spectacular hills and dynamic city centre, all within easy distance. Flinders University has recently invested more than $200 million to develop one of the most technologically advanced teaching and research institutions in the nation. Our main campus at Bedford Park is located in a natural parklike setting overlooking the city and the sea, and our new student hub in the heart of the campus has been designed and equipped to transform the way you'll learn. Our cutting-edge Computing, Science Engineering and Mathematics innovation hub at nearby Tonsley abounds with collaboration opportunities, and our business-focused city campus is perfectly located in Victoria Square in the Central Business District.

When you choose Flinders, you're choosing outstanding student support networks, modern study resources and lecturers who genuinely care about your learning. We give you the confidence to grow, learn and have an extraordinary university experience. Whatever your background, we know you will find Flinders University an inspiring and vibrant place in which to develop the skills that enable you to succeed.

We look forward to welcoming you to Australia and Flinders University, where you can achieve the extraordinary.
THOUGHT LEADER
Flinders is amongst the top 2% of universities in the world. The University was ranked in the world’s top 400 universities by the Times Higher Education Rankings 2016-17. Flinders has earned a reputation for delivering world-class courses that students love.

GEARED FOR CAREERS
Flinders University courses are renowned for being practical, as well as providing graduates with a clear set of knowledge and skills that they will be able to use in their career. There are plenty of opportunities to undertake a range of work placements; every year Flinders students choose to do an internship at the US congress, study part of their degree overseas or undertake work integrated learning opportunities with employers in Adelaide and across Australia.

LOVE TO LEARN
Flinders University offers an excellent staff-student ratio – rated 5 stars by the 2016/17 Good Universities Guide, reflecting the University’s commitment to teaching. Flinders students frequently comment that they value access to lecturers and the learning environment created on campus.

A MULTICULTURAL UNIVERSITY
Flinders University is a truly multicultural university with a diverse number of cultures represented on campus. We currently have more than 24,000 students from over 90 countries studying with us. Studying at Flinders means you join a global community and can make friends with many different people from around the world.

RESEARCH THAT MATTERS
Flinders has a world-class reputation for research and innovation, informing the professions that shape our society and developing technologies that are transforming people’s lives. Ninety percent of Flinders University’s research was ranked at or above world standard in the 2015 Excellence in Research Australia (ERA) assessment, and the discoveries of our researchers influence what you learn in the classroom.

CAMPUS DESTINATIONS
Whether you are relaxing in the leafy surrounds of the Bedford Park campus, immersed in the Adelaide city centre at the Victoria Square campus, or contemplating the future of international business at our brand new Tonsley building, Flinders prides itself on offering students a great on-campus experience.

STUDENT SUPPORT
We do an excellent job of looking after our students – academically and also in support services. Our students are among the most satisfied university students in Australia, according to the 2016 i-graduate survey (International Student Barometer). Flinders is ranked number one in Australia for overall student support.*

NEW STUDENT HUB
The $63 million Flinders Student Hub and Plaza opened in 2016. This extraordinary new facility incorporates a new retail precinct, cafes and a pub, alongside a 2,000-seat outdoor amphitheatre for concerts, night cinema and even yoga classes! With Adelaide’s best panoramic views from a rooftop garden and new social learning spaces, Flinders has a wide range of facilities available to provide you with the best possible campus experience.

** Fast facts:
- 3 LOCATIONS
- 24,000+ STUDENTS
- 3,000 INTERNATIONAL STUDENTS ON CAMPUS
- ADELAIDE, AUSTRALIA

Studying at Flinders University offers you an outstanding education in one of the world’s most liveable cities. Our courses combine academic excellence with industry experience, providing you with the skills you need to succeed in your career.

* TIMES HIGHER EDUCATION WORLD UNIVERSITY RANKINGS 2016-2017
** I-GRADUATE INTERNATIONAL STUDENT BAROMETER 2016
Flinders at Tonsley is the heart of South Australia’s new industrial future. It embodies world’s best practice in education, teaching and research. It’s a place where innovation, collaboration and entrepreneurial spirit combine to create the products and processes of the 21st century – and beyond.

More than 150 staff and 2,000 students are housed there, including two state-of-the-art lecture theatres and expansive, modern collaborative teaching spaces. The building has 28 specialised laboratories in which students can study a range of disciplines including biomedical, civil, electrical, electronic, mechanical and software engineering, information technology, network systems and mathematics.

Flinders at Tonsley is home to the New Venture Institute, Flinders Partners, Medical Device Research Institute, and Centre for Nanoscale Science and Technology alongside some of Adelaide’s biggest businesses and industries.

An integral part of studying engineering at Flinders is the opportunity to experience future employer environments first-hand with a 20-week work-integrated learning (WIL) placement. The close business-industry relationships that will be spawned by Flinders at Tonsley will further expand these WIL opportunities, which play an invaluable role in preparing job-ready graduates.
At Flinders we prepare you for the careers of tomorrow, providing you with the ‘personal enterprise’ skills you need for the many career changes you are likely to have over your lifetime.

Flinders University offers students the opportunity to embed innovation and enterprise topics within their degree. At Flinders, we recognise that careers are evolving and the workplace of the future will look very different from today’s. We’re constantly fine-tuning our degrees to empower you to create the jobs of the future.

By providing you with the skills necessary to enhance your creativity, understand and embrace innovation, and think like an entrepreneur, we’ll prepare you for graduate success. You’ll gain an understanding of the forces of disruption, using new technology and business models to succeed in the industries of today, and challenge the industries of tomorrow.

Expand your learning experience and excel in a future that will be automated, globalised and collaborative, by adding innovation and enterprise topics to your degree.

For more information, visit: study.flinders.edu.au/ie

**FLINDERS NEW VENTURE INSTITUTE**

Flinders’ New Venture Institute (NVI) is the home of innovation and entrepreneurship at Flinders. Established in 2013, the NVI accelerates graduate careers across all disciplines, building entrepreneurship skills, inspiring bold new ways of thinking, educating for the careers of tomorrow and industries of the future, and connecting business, research and students.

NVI’s location at Tonsley embeds education with business and innovation, providing a catalyst to address business challenges through experiential education. By inspiring, educating and providing invaluable industry links, NVI endeavours to create an ambitious, industry savvy community at Tonsley.

For more information, visit: nviflinders.com.au

Flinders University has strong links with industry and our students learn beyond the excellent facilities on campus.

Flinders has forged strong relationships with numerous industry partners locally and internationally, with the intention of producing job-ready graduates who meet employers’ expectations.

Many of our degrees are professionally accredited by independent industry bodies including Certified Practicing Accountants of Australia (CPA), Chartered Accountants Australia and New Zealand, the Institute of Public Accountants, the Australian Human Resources Institute and the Australian Psychology Accreditation Council (APAC).

Many of our engineering degrees are accredited by Engineers Australia and the Australian Computer Society. Both bodies are signatories to international agreements allowing graduates from accredited courses to practise around the world.

Some of the many important industry and project-based partnerships Flinders has formed include:

**BUSINESS**

**AUSTRALIAN FASHION LABELS**

Australian Fashion Labels (AFL) is a top fashion apparel company based in Adelaide, with over 3,000 stockists worldwide and international offices in Los Angeles and Shanghai. Flinders Business School students can undertake work placements at AFL and gain hands-on experience in public relations, social media, international marketing and accounting. Students have the opportunity to contribute to real campaigns, implementing marketing strategies, assisting with photoshoots and networking with industry professionals.

**INFORMATION TECHNOLOGY**

**CISCO AUSTRALIA**

Cisco, a worldwide leader in networking and the provider of state-of-the-art campus network infrastructure at Flinders, will support high quality research in emerging and innovative health technologies. Flinders and Cisco have also established a Cisco Academy at Tonsley, which delivers a curriculum to train students for the jobs of the future.

Work in the area has the potential to radically change how people interact with health services, and how they manage and maintain their health throughout life.

**MEDICINE, HEALTH & NURSING**

**SA HEALTH**

Flinders works in partnership with the South Australian Department of Health and Ageing to provide clinical training placements to our medicine, nursing and health sciences students in hospitals and health services across South Australia, primarily through the Southern Adelaide Local Health Network (SALHN) and Country Health South Australia (CHSA). These placements ensure our students are well equipped to apply the theory they learn to patients and communities in a variety of health service settings. The Flinders School of Medicine is co-located with Flinders Medical Centre – a major South Australian hospital. This means our medical and other health students have the opportunity to be exposed to authentic, patient-centred clinical experiences from early on in their course. Rural placements are also a focus of our degrees, exposing students to a professional multidisciplinary environment where patient presentations cover a wide range of needs.

**THE BEST THING ABOUT STUDYING**

**at Flinders is gaining real life experience, and implementing those experiences wherever you may work.”**

Vinh Tran

Bachelor of Business

Vietnam
Flinders is committed to preparing you for a career. To explore which career best suits you and to develop the skills and knowledge required to achieve your career goals, Flinders provides you with great education opportunities that go beyond the classroom.

We provide you with dynamic learning experiences that empower you to think big and instil within you an entrepreneurial mindset that is highly sought after globally.

Our students are encouraged to pursue international exchange opportunities, integrated work placements, fieldwork opportunities and double-degree options available across a wide range of degrees. Flinders has been awarded 4 stars for our graduate starting salaries (2016 Good Universities Guide) and our alumni are making significant contributions locally, nationally and internationally, in fields as diverse as the arts, business, sciences, humanities, linguistics, and mathematics.

WORK INTEGRATED LEARNING

We know that our students will have better career options if they graduate with both qualifications and work experience. That’s why many of our degrees give you the opportunity to undertake work components and industry initiatives, and why the Careers and Employer Liaison Centre provides a comprehensive range of career resources. Through work placements, you will spend part of your study time with industry, applying your new knowledge and testing yourself in real-world situations. These work placements give you an insight that greatly enhances both your learning and your future career prospects.

CAREERS ADVICE ON CAMPUS

Flinders University has a dedicated Careers and Employer Liaison team on campus who offer information, support, advice, seminars and events specific to international students. They can help you familiarise yourself with the structure, environment and expectations of the Australian workplace. These services continue to be available to you for up to eighteen months after you complete your studies.

A team of specialist career development consultants is also available to help you:

- develop your résumé
- write application letters
- address selection criteria
- make online applications
- find your career direction
- practise interview skills
- get career advice and support

MENTORING

The Flinders Ignite Mentoring Program offers you a career mentor to assist you get ready for the transition from study to employment. The program enables you to expand your professional networks, develop your skills and prepare for your future career. Find out more at flinders.edu.au/ignite

CAREER RESOURCES FOR YOU

- WorkReady Program provides an opportunity to undertake unpaid work experience and develop the skills employers want while learning about working in a professional environment.
- Horizon Professional Development Award provides you with a range of skill development opportunities to stand out and gain skills to become work ready.
- Daily Jobs List postings every week provide you with jobs from a range of sources relevant to you while you are studying and after you graduate.
- Career development consultants offer drop-in advisory services and job searching assistance. These services are offered in Flinders Connect.

Find out more from the careers service website: flinders.edu.au/careers

The Australian Government allows international students to work up to 40 hours per fortnight, and full-time during semester breaks. Work rights are granted automatically when you receive your visa. For more information, visit flinders.edu.au/international-students/services/working-in-australia.cfm

Flinders University Student Association lists a range of job vacancies at fusa.edu.au/jobs and local job websites include seek.com.au and careerone.com.au
Our academic staff are committed to providing both first-class education and research that makes a difference.

Flinders University seeks to foster excellence, innovation and flexibility in teaching in order to enrich the learning environment and enhance effective learning by its students.

Flinders is a member of the International Network of Universities (INU) and the Innovative Research Universities (IRU), a group of six internationally recognised, student-focused, research-intensive universities.

Flinders is ranked amongst the top 2% of universities worldwide. *

Our courses draw on the world-class research conducted at Flinders, ensuring you are taught the latest thinking across a wide range of fields.

Flinders is home to a vibrant and constantly evolving research community. Our areas of research strength operate across a range of disciplines broadly housed under five themes: biomedical and clinical sciences; culture, policy and society; health and human behaviour; molecular science; and technology, water and environment.

Ninety percent of Flinders University’s research has been ranked world-standard or above in the Australian Federal Government’s most recent Excellence in Research for Australia assessment (2015).

Flinders also appoints elite international and Australian researchers as strategic professors to sharpen the University’s research profile and build strength in areas of strategic research significance.

For more information on our research capabilities, visit: flinders.edu.au/research

*TIMES HIGHER EDUCATION WORLD UNIVERSITY RANKINGS 2016-2017

“Flinders, we teach not just for now, but for what is coming. Our students need to be ready for employment in five years’ time. The speed of change in our range of disciplines is massive, so we need to ensure we don’t just connect to industry, we contribute to it.”

Professor John Roddick
Dean of the School of Computer Science, Engineering and Mathematics
YOUR RESEARCH OPPORTUNITIES

With new research constantly making headlines, we offer an invigorating student research culture for you to immerse yourself in during your postgraduate education.

Research at Flinders explores fundamental questions and tackles the most important real-world challenges of our time. Flinders maintains a significant and growing presence in research and innovation in Australia and internationally. We host national research centres and collaborate with universities and research institutes across the world to explore a wide range of issues, ideas and problems, finding new possibilities and solutions, further questions and new knowledge.

We engage closely with industry partners and end-users to ensure that our research makes a difference. Our Medical Device Research Institute, for example, develops, tests and makes available practical tools to assist people through products and processes that are benign by design.

Climate research – This cross-disciplinary research centre is exploring the adaptive capacity of organisms to respond to environmental change in terrestrial and marine environments.

Clinical change – Filling critical gaps in our knowledge on chronic disease management and research into the development of more cost-effective health care interventions.

Health, society and equity – A national centre for research into the social determinants of health and wellbeing.

Health technologies – Medical devices and digital technologies represent one of the most rapidly growing and dynamic sectors of the economy.

Psychology, clinical health psychology, educational psychology, developmental psychology, and psychophysiology and neuroscience.

Vision – World Class researchers and state of the art facilities are bringing quality research on the highly complex link between optics of the eye and visual performance, quality of life for patients in a clinical setting and clinical trials on new imaging devices to validate their reliability to the fore.

Water and the environment – Research expertise linking biophysical study with social sciences and humanities to tackle complex water (including groundwater) and environmental problems. Researchers and professionals from multiple disciplines are pooling their expertise in major research programs to unlock the secrets of subsurface water systems.

For more information regarding these research areas and more, visit flinders.edu.au/research/our-research

YOUR STUDY OPTIONS
You can undertake postgraduate study with a program of research, coursework or a combination of both.

Pathways
Flinders University has a range of pathways to help students enter a research higher degree. Interested students can apply directly after their honours year, or upon completion of a Masters (Coursework) within a 18 Unit Thesis component. We’ve also developed a special pathway with our exclusively offered Graduate Diploma in Research Methods. This is the first course of its kind offered in Australia, and is suitable for those with no or out of date honours or Masters degree, clinicians and working practitioners, students transitioning from one discipline to another or working professionals who need an academic pathway to meet research higher degree eligibility requirements.

For further information please visit flinders.edu.au/research-degrees/

Coursework: where you usually attend lectures and tutorials, with assessment and possibly some practical work throughout the course.

Research with a coursework component: A research degree where coursework is only a minor part of the research program.

Flinders offers masters research degrees with a coursework component. These include:

• Master of Arts in Applied Population Studies
• Master of Clinical Education
• Master of Clinical Rehabilitation

This course may be undertaken as a coursework higher degree where the research component is only a minor part of the total program.

Research: Where your degree is awarded primarily on the basis of a thesis embodying the results of a unique research project.

Most students undertaking a research degree at Flinders enrol in one of the following masters or doctorate courses:

Masters
• Master of Arts
• Master of Business
• Master of Engineering
• Master of Laws
• Master of Science
• Master of Surgery
• Master of Theology

Doctorate
• Doctor of Philosophy (PhD) in all disciplines
• Doctor of Philosophy (Clinical Psychology) which includes some coursework

For more information about available postgraduate courses please visit flinders.edu.au/courses/postgrad

SUPPORT AND SCHOLARSHIPS
Flinders University encourages strong personal relationships between staff and students offering a safe, friendly and stimulating environment for you to become a part of. We take pride in our reputation for providing a wide range of services for students.

International postgraduate students applying to study at Flinders may be eligible to apply for a number of university and government funded scholarships to assist with the cost of living and studying in a foreign country. For further information on available scholarships, visit flinders.edu.au/scholarships

OFFICE OF GRADUATE RESEARCH
The Office of Graduate Research (OGR) develops policies and programs that support research higher degree students from the commencement of their degree to their final thesis submission. The OGR connects prospective students with trained high-quality supervisors, offers international travel and research opportunities, and is constantly improving and streamlining administrative processes and policies to enhance the research higher degree experience. The OGR provides tailored advice to candidates as they progress through their PhD. It manages the Register of Research Higher Degree Supervisors, cotutelle degrees and the higher degree policies and procedures. The staff in the Office of Graduate Research are able to provide advice to postgraduate research students.

Visit the Office of Graduate Research website for useful resources and information about managing your candidature: flinders.edu.au/graduate-research

In addition to services outlined elsewhere in this course guide, our commitment to international research students studying on campus includes:

• space and secure storage facilities
• use of a computer with internet access and email account
• maintenance support for consumables such as stationery, photocopying, printing, library and other research-related items.

Cotutelle
Cotutelle Doctoral Degrees allow research higher degree students the opportunity to experience an extended overseas research stay abroad (one third of their candidature), and obtain a joint PhD in the process. This enhanced program offers invaluable international networking opportunities, prized professional and personal development experience in an overseas research environment, support of two principal supervisors and an enriched PhD candidature. The Office of Graduate Research offers tailored advice and support throughout the application process. For more information about this program please visit flinders.edu.au/graduate-research/cotutelle-doctorate-degrees/

RESEARCH HIGHER DEGREE PROFESSIONAL DEVELOPMENT PROGRAM
Our Research Higher Degree Professional Development Program is available free to all students. The program helps build confidence and motivation through a series of workshops, seminars and lectures to equip you with the necessary professional and research skills upon graduation. More information can be found at the Office of Graduate Research website: flinders.edu.au/graduate-research/programs-and-courses/rdpdp.cfm

flinders.edu.au/graduate-research
Your Student Hub and Plaza is open 24/7 to help you get the most out of your on-campus experience.

The Hub brings the best of coffee and street food culture to the heart of the Bedford Park campus, with retail options, innovative study spaces and free wi-fi access. With an exciting mix of vegan, vegetarian and halal options available, there is something for everyone.

**FOOD**
- Alere Restaurant
- Grind & Press Café
- Kutchi Dei Parwana
- Tavern by Burger Theory
- Toly Vietnamese
- Subway
- Urban Paddock Co.
- Café Bon Voyage
- Student kitchen

**RETAIL**
- Pharmacy
- Post Office
- Campus Store
- Co-op bookstore
- STA Travel
- Wholefood Store

**SERVICES**
- Flinders Connect
- Flinders University Student Association (FUSA)
- Central Library
- Individual and group study spaces
- Computer access
- Wi-fi and printing
hub.flinders.edu.au

The new Student Hub and Plaza is the very heart of our Bedford Park campus for study, socialisation, recreation and student services.

**LEARN**
Whether you want a quiet space for individual study, a group study area to collaborate with your peers, or a more formal meeting room with audio-visual facilities for presentations, the Hub provides flexible variety of study spaces to suit your needs.

The Hub provides easy access to the Central Library so you can research, study and relax within close reach of the resources you need. The Central Library serves the whole Flinders community, while specialist libraries act as information hubs for those studying law, legal studies, nursing and health, and our medical programs. You will find more than one million books and journals, extensive electronic collections, and a wide range of services and facilities to support your learning and research interests.

**CONNECT**
Find a computer on campus or bring your own and connect to our free, secure and fast eduroam wi-fi network.
You can also access print stations in the Hub and Library using a Mac or PC, or by connecting your device using your Unicard.

**PLAY**
Soak up the fresh air in the 2,000-seat terraced amphitheatre, which features a giant super screen and plays host to everything from video-game challenges to moonlight cinema and Adelaide Fringe events.
You can also relax in the Hub’s Club Lounge, where you can hang out with friends and watch TV, play Xbox or just let the rest of the University hurry by.

**YOUR CAMPUS EXPERIENCE**

Flinders provides a range of venues and services to help you enjoy your life on campus.

**FLINDERS UNIVERSITY STUDENT ASSOCIATION (FUSA)**
Run for students by students, the Flinders University Student Association (FUSA) develops life and culture on campus. Membership is free.
FUSA represents your rights and interests, and provides a range of services to students looking for support or advice.
FUSA can help with academic support, student advocacy and financial guidance. Financial assistance through annual grants and emergency loans is available, and a range of services including casual employment placements and DVD lending is also on offer. For more information, visit: fusa.edu.au/clubs

**CLUBS AND SOCIETIES**
Non-sporting clubs operate under the umbrella of the Flinders University Student Association, as does the student-run magazine Empire Times.
Flinders has a range of clubs and societies to cater to your interests, whether they are related to your degree, religion, culture, political affiliation, or just for fun. Becoming a part of a club is a great way to get involved in campus life, to meet people and to gain valuable organisational experience. If you can’t find a club or society that meets your interest, start your own! For more information, visit: fusa.edu.au/clubs

**FLINDERS UNIVERSITY ART MUSEUM AND CITY GALLERY**
Established as a dynamic teaching resource, the Flinders University Art Museum houses an expanding collection of art to excite your senses, inspire the imagination and foster new ways of thinking.
The museum connects with and actively engages students of all ages with its historical and contemporary collections of European Master prints, Aboriginal and Torres Strait Islander art, Australian political posters and post-object collection.
The museum serves both the University and the community through the delivery of exhibitions, public programs and research opportunities. Visit: flinders.edu.au/artmuseum

Students taking a break in the Student Hub and Plaza

Study space in the Student Hub and Plaza

The new Student Hub and Plaza is the very heart of our Bedford Park campus for study, socialisation, recreation and student services.
Choose Adelaide

Adelaide is the capital of South Australia – a city of festivals, relaxed living and education excellence.
Australia's Most Affordable Mainland Capital

Your money will go much further in Adelaide. Statistics show it costs around 20% less to live in Adelaide than Sydney and Melbourne.* This means more money to discover Australia during your study breaks.

Student Support

Study Adelaide runs a year-long calendar of free and discounted events especially for international students. From tickets to sporting matches and arts events to employment seminars and regional tours, you can discover everything Adelaide has to offer. As soon as you arrive, you’ll be given a free welcome backpack and guide with everything you need to know about living in Adelaide. For more information, visit: studyadelaide.com

An Authentic ‘Aussie’ Experience

South Australia offers an authentic Australian experience. The state offers a mix of beautiful landscapes, sparkling beaches, rolling hills and a vibrant urban centre. Visit our world famous wine regions, the rugged Flinders Ranges, and popular metropolitan beaches, or see Australian wildlife on Kangaroo Island. All this, and more, is waiting for you.

A High Standard of Living

Studying in Adelaide means you are also residing in one of the world’s most liveable cities. We have a relaxed, easy-going lifestyle and Adelaide has been acknowledged as Australia’s safest city. Adelaide is in the Top 5 liveable cities in the world (Global Liveability Study 2016) and one of the world’s Top 10 cities to visit (Lonely Planet 2014). Adelaide is ranked the 26th best city in the world for student living worldwide (QS Best Student Cities 2016).

Fast Facts

- No. 9 - Lonely Planet’s Top 10 cities in the world to visit
- Most Affordable Mainland Australian Capital City
- Top 5 Liveable Cities of the World

South Australia has beautiful beaches
ADELAIDE: A VIBRANT CITY

Enjoy a safe, relaxed lifestyle in our vibrant city.

SAFETY AND SECURITY

Safety and security is another key part of life in Adelaide. It is a relatively safe city by international standards and has been recognised as Australia’s safest city.

On campus, students are able to enjoy the safe environment provided by our 24-hour security service.

GETTING AROUND

Adelaide is well serviced by public transport, which covers the greater metropolitan region with trains, buses and trams. International students in Adelaide receive the same transport concessions as local students, saving you up to $700 per year on transport costs. A free tram and bus service runs in the Adelaide city centre.

Buses run frequently to and from Flinders University and the adjacent Flinders Medical Centre, with various routes running directly from the city and suburbs. As of 2018, a new train extension will connect Flinders to the city, making it even easier to get around.

Adelaide is also a cycling-friendly city, with a large community of cyclists and world-class cycling events. There are plenty of opportunities to buy new and second-hand bikes.

FESTIVALS

South Australia is often called the ‘Festival State’, and there are regular cultural and social events including WOMADelaide, the nation’s favourite outdoor world music festival, and the world-renowned Adelaide Festival and Fringes. As well as the music and multicultural events, you’ll also enjoy a number of sporting festivals including cycling’s Tour Down Under and the V8 Supercars Clipsal 500 car race. There is something for you to enjoy year round whatever your taste! For more information visit: southaustralia.com

FOOD

South Australia has a reputation for being a food centre, with a higher ratio of cafés and restaurants to residents than any other city in Australia.

Our state is well-known for the quality of our produce – from fresh fruit and vegetables through to the finest meat and seafood. We have a vibrant market culture. The city’s proximity to well known produce regions, such as the Barossa Valley and McLaren Vale, offers residents easy access to a number of farmers markets selling fresh, seasonal and regional goods. The range of food available is also a reflection of our multicultural city. Adelaide is well-equipped for vegan and vegetarian students. There is also a range of grocery stores, restaurants, butchers and takeaway food outlets that offer Halal or Kosher food.

SHOPPING

From high-end brands to local retailers, Adelaide has a wide range of choices, making it easy to shop for any taste or budget. Westfield Marion, the biggest shopping mall in Adelaide, is located just 10 minutes from our Bedford Park campus. Rundle Mall, located in the city centre, offers a strip of pedestrianised shopping with department stores and high street brands, while the café-lined Rundle Street is home to designer labels. Further out of the city there is a host of charming shopping streets: Norwood Parade, Unley Road and King William Road all offer the best of designer and high-street shopping.

ADELAIDE: A VIBRANT CITY

“Adelaide is a great place to live. There is always a market or festival for me to enjoy and there are plenty of opportunities to make friends, de-stress and enjoy the beautiful surroundings Adelaide has to offer.”

Victoria Yeo
Bachelor of Clinical Sciences
Singapore

“Adelaide is a great place to live. There is always a market or festival for me to enjoy and there are plenty of opportunities to make friends, de-stress and enjoy the beautiful surroundings Adelaide has to offer.”

Victoria Yeo
Bachelor of Clinical Sciences
Singapore

Adelaide Central Markets

Clockwise from top: The Gallery rooftop bar; Santos Tour Down Under cycling race; Adelaide Oval; Glenelg beach; Adelaide skyline

*SUNCORP BANK FAMILY FRIENDLY CITY REPORT 2013
LIVING IN ADELAIDE

Living in Adelaide is easy. Adelaide is one of Australia’s most liveable cities and a great place to study.

Adelaide is more affordable than Sydney, Melbourne, Perth and Brisbane.

It is recommended that individuals budget between $19,830 to $26,288 for annual living costs in Australia. This estimate will increase if individuals are accompanied by partners and children.

Websites to assist you in developing a budget for living costs include:

education.gov.au/australian-postgraduate-awards
moneysmart.gov.au/managing-your-money/budgeting

Estimated Cost of Living

Average weekly costs* $ AUS
Accommodation (shared or single) $135-250
Public transport $20-35
Food (eating at home) $90-135
Utilities (Electricity/gas/water) $40-55
Telephone and internet $20-40
Clothes/Entertainment $50+
Total $355-565

* These prices are estimated for 2018

WEATHER

South Australia is fortunate to have a Mediterranean climate, with long, hot summers and cool to cold, snowless winters.

Spring (September to November) 20°C to 25°C / 68°F to 77°F
Winter (June to August) 10°C to 15°C / 50°F to 59°F
Summer (December to February) 25°C to 35°C / 77°F to 95°F
Autumn (March to May) 20°C to 25°C / 68°F to 77°F

Time difference between Adelaide and overseas:
• Indonesia – less 2.5 hours
• Singapore – less 1.5 hours
• Malaysia – less 1.5 hours
• China – less 1.5 hours
• United Arab Emirates – less 5.5 hours
• Germany – less 7.5 hours
• United Kingdom – less 9.5 hours
• USA – less 18 hours

WEBSITE

Barossa Valley vineyards

There are many direct flights into Adelaide from all around the world. Flinders University also offers a free meet-and-greet service at the airport for new international students. See page 28 for details.

Barossa Valley vineyards

There are many direct flights into Adelaide from all around the world. Flinders University also offers a free meet-and-greet service at the airport for new international students. See page 28 for details.

Barossa Valley vineyards

There are many direct flights into Adelaide from all around the world. Flinders University also offers a free meet-and-greet service at the airport for new international students. See page 28 for details.

Barossa Valley vineyards

There are many direct flights into Adelaide from all around the world. Flinders University also offers a free meet-and-greet service at the airport for new international students. See page 28 for details.

Barossa Valley vineyards

There are many direct flights into Adelaide from all around the world. Flinders University also offers a free meet-and-greet service at the airport for new international students. See page 28 for details.
ACCOMMODATION IN ADELAIDE

Flinders is the only university in Adelaide where you can choose to live on-campus. Experience all the friendship, support and social opportunities that help make Flinders such a great place to live and study.

ON-CAMPUS LIVING

The Flinders campus is safe, affordable and convenient. By living on-campus you will be part of a diverse community of students from across Australia and over 30 countries worldwide.

You have the option of living either at the catered University Hall or independently in the self-catered Deirdre Jordan Village. Both options offer academic and personal support from in-house tutors and coordinators. Public bus services run regularly to the local shopping precinct, beach and city centre.

Temporary accommodation is also available when you first arrive in Adelaide during the December to mid-February period (depending on availability).

More information and current fees can be found at: flinders.edu.au/living

UNIVERSITY HALL

The University Hall is a catered collegiate residence with a strong collegial atmosphere. The hall has accommodation for over 250 students in fully-furnished single rooms, secure storage and car parking and small communal kitchens. You can mix with other students in common areas, sporting areas, the outdoor cinema, gazebos and gardens including a landscaped central courtyard.

Cost: $395 per week for a single room, including 15 professionally prepared meals per week.*

DEIRDRE JORDAN VILLAGE

The Deirdre Jordan Village provides modern accommodation in self-catered fully-equipped units. The village also offers a range of culturally inclusive activities in the community centre for those who wish to develop a strong community atmosphere.

The village has accommodation for over 300 students, living areas (some private), landscaped gardens and outdoor areas with barbecues and secure storage and car parking. Single gender accommodation is also available.

Cost: $250 per student per week, including all utilities.*

For more information, please visit: flinders.edu.au/living

LIVING OFF-CAMPUS

With Flinders University’s convenient location and so many transport and accommodation options available, living off-campus is easy.

Flinders Living runs a free service that lists the private rental accommodation available off-campus in the local area. They can also provide advice on your rights and responsibilities as a tenant.

For more information about the type, cost and availability of accommodation in Adelaide, please visit:

flinders.edu.au/living/short-term-private/private-accommodation
realestate.com.au
homehound.com.au
domain.com.au
homestaynetwork.org
adelaidehomestaysearch.com

*costs are based on 2017 rates
GETTING SETTLED
We help you to settle in here at Flinders, from arrival at the airport through to your first day on campus and beyond. There are a range of on-campus services to help you quickly settle into your new life at Flinders.

ORIENTATION
The first few days of university are exciting but can also be daunting, which is why we have a number of orientation sessions and programs to help you get used to the University community. These include the Flinders International Student Orientation (covering enrolment and important government regulations relating to your stay in Australia) and APP (a series of lectures based on academic strategies and skills). Finally, your own faculty or school will also have special induction events that will introduce you to the teaching team and help you to get to know your colleagues in class.

Our commitment to excellent student services goes well beyond helping you to settle in when you arrive. We also have a range of student services available to assist you throughout your studies. Visit: flinders.edu.au/international/services

FLINDERS CONNECT
Flinders Connect provides you with centralised access to frontline University services. With a physical location next to the new Student Hub at Bedford Park, as well as phone and online channels, Flinders Connect is an initial point of contact and first point of call for information and support services queries. The Flinders Connect team can assist you with enquiries relating to enrolments, fees, ID cards, parking permits and a range of other general enquiries.

Flinders Connect face-to-face and phone services are available Monday to Friday, 9am to 5pm. You will also have access to an easy to use online self-service area where you can search for answers on the FAQs database at any time. Visit: flinders.edu.au/flindersconnect

EMPLOYMENT AND CAREERS
Flinders has a dedicated Careers and Employment Liaison Centre on-campus, and offers a number of career resources to support you. For more information, please see page 11, or visit: flinders.edu.au/careers

CHILDCARE
The Flinders University Childcare Centre offers childcare for children under school age. Community-based and not-for-profit, the centre has attained the highest level of accreditation. The experienced and qualified staff offer exceptional care and education in a nurturing and stimulating environment. Please note, places are limited and booking is essential. More information is available at: flinders.edu.au/childcare

DISABILITY SUPPORT
Flinders is committed to providing access and equity for students with disabilities and helping everyone fully participate in the academic, cultural and social life at Flinders. Our disability advisers provide a free, confidential service and are the first point of contact for students who may need assistance because of their disability. They are here to help you better access university study, act as advocates on behalf of individuals or groups, and liaise with lecturers to negotiate reasonable adjustments to teaching or assessment methods. Visit: flinders.edu.au/disability-services

YOUR ARRIVAL SERVICES
Flinders University is a leading Australian university in terms of arrival support for new students from overseas. Even before you leave your home country, ISS will assist you to plan your arrival with useful information about Flinders and living in Adelaide. They will help you to settle in by connecting you with a range of on-campus support services and staff in your academic area, making your transition to Flinders as smooth as possible.

FREE MEET AND GREET SERVICE
The ISS offers a free meet-and-greet service for new international students. You will be met at Adelaide airport, the railway station or the central bus station and taken directly to your new accommodation. The service is also free for accompanying family members. To book, visit: flinders.edu.au/international/services

“The Flinders is full of opportunities, the international student support team and counsellors are amazing.”
Dharshinine Vimalanathan, Bachelor of Psychological Sciences, Malaysia

HEALTH AND COUNSELLING
The Flinders University health service is a fully equipped and accredited medical centre providing a wide range of medical services. Male and female medical practitioners are available by appointment.

The free and confidential counselling service assists students who may be experiencing difficulties studying due to personal or social problems. Counsellors are available to talk to you about issues relating to study, relationships, family, or specific learning disabilities. Whatever your health and counselling needs, our psychologists and social workers can help you get back on track. Visit: flinders.edu.au/healthcounsel

OASIS
Oasis is a multi-faith, multicultural centre where support is provided by chaplains of all faiths to meet the spiritual and religious needs of the Flinders community. Oasis offers various forms of prayer and meditation, seminars, and study and discussion groups, as well as a drop in centre for friendship over tea and coffee. Visit: flinders.edu.au/oasis
ACADEMIC SUPPORT

Flinders University provides a range of support services to help students to achieve their full academic potential.

ACADEMIC SUPPORT IN CLASS

We pride ourselves on the quality of Flinders University academic staff, their expertise and knowledge. When you are learning in our environment, you are often learning from a world leader in their field.

But the quality of academic staff is not just measured in terms of knowledge. Our academics are approachable and willing to work with you to help you meet and exceed your own expectations.

STUDENT LEARNING CENTRE (SLC)

The SLC provides learning support for Flinders University students, ranging from writing and maths support to assistance with study and time-management skills. More information is available at: flinders.edu.au/slc

LIBRARY

Across our four library sites, you will find more than one million books and journals, extensive electronic collections and a wide range of services and facilities to support your learning and research interests. The main library serves the whole Flinders University community while specialist libraries act as information hubs for those studying law, legal studies, nursing and health, and our medical programs. The libraries are more than collections of books – each library has study areas with dedicated internet and email workstations, computers for student work, and printing and photocopying services. The library, with its thousands of journal articles and electronic books, can be accessed online at: flinders.edu.au/library

WORLD-CLASS INFORMATION AND COMMUNICATIONS TECHNOLOGY

Flinders offers one of the fastest, most secure campus wireless networks in the Southern Hemisphere. You will have access to world-class communications technology thanks to our $14 million investment with leading international supplier, Cisco.

The system allows students and staff to connect to a high density, high speed wireless network that will support interactive student experiences, lectures by high definition video, video conferencing, stronger research capability, and enhanced social media relationships.

COMPUTER FACILITIES

Our campus is wired for 21st-century learning. You can work at your own pace anywhere in the University by accessing our extensive wireless network. The system allows students and staff to connect to a high density, high speed wireless network that will support interactive student experiences, lectures by high definition video, video conferencing, stronger research capability, and enhanced social media relationships.

FLINDERS LEARNING ONLINE (FLO)

FLO enables you to access course materials and resources, enrol or withdraw from topics, check your email accounts, and keep up-to-date with University-wide announcements. Visit: flo.flinders.edu.au

ENGLISH LANGUAGE SUPPORT PROGRAM

The Student Learning Centre (SLC) offers a free program to support Non-English Speaking Background students who need to improve their English in the academic context. More information is available at: flinders.edu.au/slc

AWARD-WINNING STUDENTS

Our students are recognised as leaders who drive positive change. The impact of their work is being felt across the globe.

Flinders University student, Dr Emmanuel Ita Bassey, beat hundreds of entrants from major South Australian universities to win South Australian International Student of the Year 2016.

The former clinician, who lost his sight to cataract disease several years ago, has established a visual rehabilitation unit in a tertiary eye hospital in Nigeria to save people travelling up to 2,000km for treatment. As well as being Medical Officer (Visual Rehabilitation) at the hospital, he is Acting Secretary of the Nigerian Computer Association of the Blind.

“Receiving this award is such an amazing honour,” Dr Bassey says.

“When I lost my sight, I couldn’t practise medicine anymore and that’s why I’m in Australia to do this disability study.

“Now I’ve applied to Flinders to commence a PhD in disability studies in July 2017 to continue helping Nigerians with adult-onset visual impairment and many other disabilities.”

Studying at Flinders as an Australia Awards scholar, Dr Bassey has received a letter of commendation from Flinders University Chancellor and been recognised by the Golden Key International Honours Society for academic excellence.

Vice-President and Pro Vice-Chancellor (International) Sebastian Raneckild says there are hundreds of nominations every year from across South Australia’s educational institutions for the International Awards.

“Emmanuel’s outstanding academic capabilities, and inspiring career goals and personal attributes, made him a very worthy recipient of the International Student of the Year and Academic Excellence awards this year,” Mr Raneckild says.

“Even more importantly, he will use his Flinders University study to further improve the lives of many more Nigerian people living with disabilities to reach their full potential.”

He also was joint winner with Flinders Master of Teaching (Early Childhood) student Ziya Wong (Singapore) for the Excellence in Academic Postgraduate Coursework Award.

Other Flinders University international students acknowledged at the award ceremony were:

Undergraduate Academic Excellence – winner Rachel Master (from Norway / US) who is studying Bachelor of Information Technology (Digital Media) Honours, and highly commended Karen Wu (China) Bachelor of Clinical Sciences, Doctor of Medicine.

Community Engagement – high commendations to Guixing (Henry) Liu (China) and Anupol Bordoloi (India), both studying Master of Social Work at Flinders.

Artistic Achievement – highly commended Li Jiaming (China), Master of Social Work.

“Flinders has given me the opportunity to gain both professional and practical experience... It has ensured that I have the best possible chance to succeed.”

Aqeel Asad
Bachelor of Business
Pakistan

“Awards at Government House Australia to do this disability study. “When I lost my sight, I couldn’t practise medicine anymore and that’s why I’m in Australia to do this disability study.

“Now I’ve applied to Flinders to commence a PhD in disability studies in July 2017 to continue helping Nigerians with adult-onset visual impairment and many other disabilities.”

Studying at Flinders as an Australia Awards scholar, Dr Bassey has received a letter of commendation from Flinders University Chancellor and been recognised by the Golden Key International Honours Society for academic excellence.

Vice-President and Pro Vice-Chancellor (International) Sebastian Raneckild says there are hundreds of nominations every year from across South Australia’s educational institutions for the International Awards.

“Emmanuel’s outstanding academic capabilities, and inspiring career goals and personal attributes, made him a very worthy recipient of the International Student of the Year and Academic Excellence awards this year,” Mr Raneckild says.

“Even more importantly, he will use his Flinders University study to further improve the lives of many more Nigerian people living with disabilities to reach their full potential.”

He also was joint winner with Flinders Master of Teaching (Early Childhood) student Ziya Wong (Singapore) for the Excellence in Academic Postgraduate Coursework Award.

Other Flinders University international students acknowledged at the award ceremony were:

Undergraduate Academic Excellence – winner Rachel Master (from Norway / US) who is studying Bachelor of Information Technology (Digital Media) Honours, and highly commended Karen Wu (China) Bachelor of Clinical Sciences, Doctor of Medicine.

Community Engagement – high commendations to Guixing (Henry) Liu (China) and Anupol Bordoloi (India), both studying Master of Social Work at Flinders.

Artistic Achievement – highly commended Li Jiaming (China), Master of Social Work.

“Awards at Government House Australia to do this disability study. “When I lost my sight, I couldn’t practise medicine anymore and that’s why I’m in Australia to do this disability study.

“Now I’ve applied to Flinders to commence a PhD in disability studies in July 2017 to continue helping Nigerians with adult-onset visual impairment and many other disabilities.”

Studying at Flinders as an Australia Awards scholar, Dr Bassey has received a letter of commendation from Flinders University Chancellor and been recognised by the Golden Key International Honours Society for academic excellence.

Vice-President and Pro Vice-Chancellor (International) Sebastian Raneckild says there are hundreds of nominations every year from across South Australia’s educational institutions for the International Awards.

“Emmanuel’s outstanding academic capabilities, and inspiring career goals and personal attributes, made him a very worthy recipient of the International Student of the Year and Academic Excellence awards this year,” Mr Raneckild says.

“Even more importantly, he will use his Flinders University study to further improve the lives of many more Nigerian people living with disabilities to reach their full potential.”

He also was joint winner with Flinders Master of Teaching (Early Childhood) student Ziya Wong (Singapore) for the Excellence in Academic Postgraduate Coursework Award.

Other Flinders University international students acknowledged at the award ceremony were:

Undergraduate Academic Excellence – winner Rachel Master (from Norway / US) who is studying Bachelor of Information Technology (Digital Media) Honours, and highly commended Karen Wu (China) Bachelor of Clinical Sciences, Doctor of Medicine.

Community Engagement – high commendations to Guixing (Henry) Liu (China) and Anupol Bordoloi (India), both studying Master of Social Work at Flinders.

Artistic Achievement – highly commended Li Jiaming (China), Master of Social Work.
The different perspectives I was able to experience were the most rewarding to me. I learned how to really enjoy my time, learned so many things from the people I met, and was able to see that I had more options in what I wanted to do with my life.

Avery Cheatham
Butler University, USA

“Go for on-campus housing! You’ll meet a lot of people and it will help you adjust to the Australian culture easier! It was very easy living on campus; I lived with a lot of other [foreign] students which made it easier to make friends and meet the locals.”

Arjen van Lil, Utrecht University, Netherlands

Study Abroad and Student Exchange are short term programs that enable you to study for six to twelve months (one or two semesters) in Adelaide.

Study Abroad and Student Exchange enable you to live in a new city, enhance your career prospects, undertake professional development opportunities, experience a different culture and meet new people without interrupting your studies or career path.

STUDENT EXCHANGE
If you’re studying at one of our partner institutions, you may be eligible for the student exchange program. Contact your home institution for application information.

STUDY ABROAD
If you are not studying at a Flinders University exchange partner or currently enrolled at an overseas university, we offer you the opportunity to study on a fee paying basis. Flinders University offers multiple options to suit your academic, career and lifestyle goals.

You are required to study a minimum of three topics per semester to maintain a full-time study load. You are also able to study four or five topics per semester.

TUITION FEES
3 topics: $6,750 AUD
4 topics: $9,000 AUD
5 topics: $11,250 AUD

To find out more, visit: flinders.edu.au/studentexchange

Flinders University’s links span the globe. We have partnerships in areas of research, teaching and offshore delivery, and offer exchanges with over 100 institutions globally.

BRAZIL
University of Sao Paolo

CANADA
Simon Fraser University

CHILE
Universidad de Valparaiso

CHINA
Capital Normal University

Central South University

Chinese Academy of Social Sciences

Nankai University

GERMANY
Brandenburg University of Technology

HONG KONG
The Chinese University of Hong Kong

University of Hong Kong

INDIA
Amity University

Manipal University

INDONESIA
Universitas Airlangga

Universitas Gadjah Mada

Universitas Indonesia

JAPAN
Hirosima University

National Institute for Materials Science

KOREA
Kyung Hee University

Chungnam National University

MALAYSIA
HELP University

Universiti Kebangsaan Malaysia

Universiti Malaya

MALAWI
University of Malawi

MEXICO
The Autonomous University of Queretaro

NETHERLANDS
Utrecht University

Maastricht University

SINGAPORE
Nanyang Technological University

Parkway College of Nursing & Allied Health

Social Service Institute (SSI)

SWEDEN
Malmö University

THAILAND
National Nanotechnology Centre

UK
St George Hospital Medical School

University College London

University of Birming

USA
Johns Hopkins University

Temple University – Fox School of Business

University of Arizona

University of Texas at Austin

Students chatting in The Tavern, Bedford Park campus

Flinders’ Bedford Park campus has coastal views and lots of green spaces to relax
Flinders University offers over 110 world-class postgraduate courses across 15 study areas. The following pages provide a summary of these courses and their entry requirements. For more detailed information on our courses, visit: flinders.edu.au/courses
The Master of Accounting is designed to provide undergraduates of non-accounting degrees with a study program that fulfills the requirements to commence a professional accounting career. Flinders Business School provides excellent teaching, small classes and opportunity to network and develop professional acquaintances through interaction in these programs.

Industry experience: Students may have the opportunity to undertake an industry placement and for industry project.

Professional accreditation: The Master of Accounting meets the admission requirements of the Certified Practicing Accountants of Australia (CPA), Chartered Accountants in Australia and New Zealand (CAANZ) and the Institute of Public Accountants (IPA).

STUDY PROGRAM

Topics may include:
> Accounting Fundamentals
> Information Systems and Accounting Processes
> Quantitative Methods
> Economics for Business
> Management and Cost Accounting
> Principles of Commercial Law
> Financial Accounting Issues
> Financial Management
> Corporate Accounting
> Auditing and Assurance
> Business Research Methods and Project
> Academic Skills for Business - specifically aimed at Non-English Speaking Background postgraduate students.

CAREER OUTCOMES

Graduates are suitable for careers such as auditor, budget accountant, cost accountant, finance manager, investment analyst, systems accountant, and taxation advisor. Students may also pursue postgraduate accounting qualifications in financial management and planning firms, investment advisory organisations and government departments. Opportunities also exist for self-employment.

FURTHER COURSE INFORMATION

flinders.edu.au/courses/postgrad/macc
CRICOS Code: 064298M

ACCOUNTING AND FINANCE

Master of Accounting and Finance

> Course length: 2 years full-time
> Intake: Semester 1 + Semester 2
> Opportunity for industry experience

Entry requirements: Applicants must normally hold an approved bachelor degree or equivalent qualification in any discipline (other than accounting degree accredited in Australia). Applicants with an Australian accredited degree in accounting are not eligible for admission into the Master of Accounting and Finance.

Note: Taught at Flinders City Presence, Victoria Square, Adelaide CBD

The Master of Accounting and Finance offers the right balance of practice and theory to prepare students for a successful career as an accounting or business professional and to cultivate research practices for independent, industry and discipline related publications.

The role of accounting and finance professionals in contemporary society will be explored with reference to ethics, globalisation and sustainability issues.

Industry experience: The opportunity to undertake Work Integrated Learning in this program is dependent upon whether CPA accreditation is also sought. (Note: Taking this topic may preclude entry into the CPA, please speak to a student advisor prior to taking this topic).

Professional accreditation: The Master of Accounting and Finance meets the admission requirements of the Certified Practicing Accountants of Australia (CPA), Chartered Accountants in Australia and New Zealand (CAANZ) and the Institute of Public Accountants (IPA).

STUDY PROGRAM

Students will have core and advanced Accounting and Finance topics to choose from including Accounting Fundamentals, Financial Accounting Issues, Decision Management and Investment and Portfolio Management. For further details refer to: flinders.edu.au/courses/rules/postgrad/macf.mcm

We offer an ‘Academic Skills for Business’ topic, specifically aimed at Non-English Speaking Background postgraduate students. (Note: Taking this topic may preclude entry into the CPA, please speak to a student advisor prior to taking this topic).

CAREER OUTCOMES

Potential roles include accountant, auditor, business analyst, client service advisor; finance officer; investment consultant, superintendent manager and tax accountant. Potential employers include financial management firms, investment advisory organisations, financial planning firms and government departments. Opportunities also exist for self-employment.

FURTHER STUDY

Students may choose to undertake further postgraduate study in research.

FURTHER COURSE INFORMATION

flinders.edu.au/courses/postgrad/acfinance
CRICOS Code: 089466G

ARCHAEOLOGY AND HERITAGE MANAGEMENT

Graduate Certificate in Archaeology; Graduate Diploma in Archaeology and Heritage Management; Master of Archaeology and Heritage Management

> Course length: 6 months full-time
> Intake: Semester 1 + Semester 2
> Opportunity for industry experience

Entry requirements: Graduates of any discipline who have completed a substantial independent research project (thesis) with guidance from a suitably qualified examiner will be considered for entry into this program. Flinders University may, in certain circumstances and subject to specific conditions, admit others who can show evidence of fitness for candidature.

This articulated program aims to meet the research and professional needs of graduates with an interest in Indigenous pre-colonial and historical archaeology, cultural heritage management, and archaeological method and theory. Flinders University offers a range of archaeology topics, including material culture, human evolution, prehistory and historical archaeology, with the opportunity to undertake Work Integrated Learning through placement in an archaeological consultancy firm, government agency or museum.

STUDY PROGRAM

Students will have core and advanced Archaeology and Heritage topics to choose from including Principles of Archaeology, Indigenous Heritage Issues, and Contemporary Issues in Heritage Management.

CAREER OUTCOMES

You may also choose from a range of related disciplines.

CAREER OUTCOME

The courses develop an understanding of archaeological principles and practices in nutrition and water quality, reproduction and genetics, hatchery management, ecology and physiology, husbandry and production, health management and disease control, product quality, aquaculture system and technology, experimental design and statistics for biology, fisheries biology and management and bio-business. The program involves practicals in laboratories, aquaria and tanks, meeting with aquaculture professionals and a flexible choice of elective topics available from different disciplines. The Master of Science (Aquaculture) course can be fast-tracked in 18 months.

FURTHER COURSE INFORMATION

flinders.edu.au/courses/postgrad/sgaq
CRICOS Code: Graduate Certificate – External only. Graduate Diploma – 080523K, Masters – 080524J, Masters Advanced Entry 1.5 years – 089090E.
Audiology
Master of Audiology

Entry requirements:
Approved bachelor degree with a minimum of credit average. No specific undergraduate degree is required for admission. Admission will be based on the combined scores from a structured interview (may be by skype) and the applicant’s best GPA using a minimum of 36 units of a qualification from an approved tertiary institution.

Note: A limited number of places are available. All students who undertake the Master of Audiology are required to undertake specified health checkups, immunisations and criminal history checks as per University and Health Department guidelines.

The Master of Audiology is a professionally oriented course for graduates interested in acquiring knowledge and skills in the evaluation and management of auditory disorders (hearing loss and tinnitus) and their consequences. It prepares graduates to begin clinical practice as audiologists in a range of urban, rural and remote settings, to be well-informed health professionals, and to acquire critical skills in appraising scientific and clinical information which will assist further professional development. The program offers innovative learning experiences including problem-based learning tutorials, clinical skills classes and clinical placements.

Industry experience:
Students will have the opportunity to undertake a clinical placement.

Professional accreditation:
Graduates of the Master of Audiology will meet the standards set out by Audiology Australia.

CAREER OUTCOMES
Graduates of the Master of Audiology will be suitable for careers in the public and private sectors in Professional Studies.

Biology
Graduate Certificate in Bacteriology; Graduate Diploma in Bacteriology; Master of Bacteriology Studies

Entry requirements:
Bachelors degree or equivalent in biological, agricultural or medical science with a GPA of 0.5 or higher.

Biotechnology
Graduate Certificate in Biotechnology; Graduate Diploma in Biotechnology; Master of Biotechnology

Entry requirements:
Approved bachelor degree with a minimum of credit average. No specific undergraduate degree is required for admission. Admission will be based on the combined scores from a structured interview (may be by skype) and the applicant’s best GPA using a minimum of 36 units of a qualification from an approved tertiary institution.

Note: A limited number of places are available. All students who undertake the Master of Biotechnology are required to undertake specified health checkups, immunisations and criminal history checks as per University and Health Department guidelines.

The Master of Biotechnology is the use of living organisms and their biological components to create products or perform tasks. Flinders University was one of the pioneers of biotechnology teaching in Australia. The Biotechnology Program has combined the best expertise in both the School of Biological Sciences and the School of Medicine.

In addition to teaching, staff run world class research programs in a wide range of areas of biotechnology including cancer and immunobiology, recombinant bio-processing, plant disease resistance, bio-control, therapeutic drug discovery, functional foods, bio-energy, water quality and marine biotechnology. The biotechnology courses at Flinders are designed to provide students with advanced theoretical scientific knowledge and training, and an understanding of business issues required for modern biotechnology. Theoretical scientific knowledge is complemented by relevant practical laboratory training and backed up by business training in financial, marketing and management skills. The law, ethics, society and the environment have great relevance in biotechnology and all are examined.

CAREER OUTCOMES
Potential roles include bioanalytical chemist, biodiscovery research scientist, business development manager, medical scientist, biotechnologist and clinical researcher. Graduates of these programs are job ready and highly skilled for medical, pharmaceutical, agricultural, industrial and environmental applications.

FURTHER STUDY
The courses articulate and the sequentially developed topics allow progression through the three awards. The Masters program can provide a pathway to a PhD for those who want to pursue a research career.

Business
Master of Business

CAREER OUTCOMES
Our programs in Business are designed to provide a strong foundation in appropriate business knowledge, understanding, skills and attitudes for successful careers as managers of organisations including private sector business, not-for-profit, government and public sector entities. Flinders Business Schooll’s teaching philosophy and small class sizes ensure that you can really engage with your teacher, while getting to know your fellow students.

Industry experience:
Students may have the opportunity to undertake an industry placement and/or project.

STUDY PROGRAM

Topics towards the Master of Audiology may include:

> Audiology
> Clinical Audiology
> Professional Studies
> Research Methods
> Research Project

CAREER OUTCOMES
Graduates of the Master of Audiology are suitable for careers in the public and private sectors in Professional Studies.

STUDY PROGRAM

Topics studied may include:

> DNA to Genome
> Protein to Proteome
> Molecular Biotechnology
> Legal, Ethical and Social Aspects of Bioscience
> Professional Skills for Biotechnology
> Industrial and Pharmaceutical Biotechnology
> Environmental Biotechnology
> Plant and Food Biotechnology

CAREER OUTCOMES
Potential roles include bioanalytical chemist, biodiscovery research scientist, business development manager, medical scientist, biotechnologist and clinical researcher. Graduates of these programs are job ready and highly skilled for medical, pharmaceutical, agricultural, industrial and environmental applications.

FURTHER STUDY
The courses articulate and the sequentially developed topics allow progression through the three awards. The Masters program can provide a pathway to a PhD for those who want to pursue a research career.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/bt
CRICOS Code: 03767G

Our programs in Business Administration are designed to provide a strong foundation in appropriate business knowledge, understanding, skills and attitudes for successful careers as managers of organisations including private sector business, not-for-profit, government and public sector entities. Flinders Business Schooll’s teaching philosophy and small class sizes ensure that you can really engage with your teacher, while getting to know your fellow students.

Industry experience:
Students may have the opportunity to undertake an industry placement or project.

STUDY PROGRAM

MBus specialisations include:

> Human Resource Management
> International Business
> Finance
> Marketing

We offer an ‘Academic Skills for Business’ topic, specifically aimed at non-English Speaking Background postgraduate students.

CAREER OUTCOMES
These programs provide a strong foundation in appropriate business knowledge for a successful career in areas including business, international marketing, banking and finance, management consulting, and negotiation and planning. Potential roles include senior product marketing manager, equity analyst, operational risk manager, finance manager, process improvement consultant and senior business development manager.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/mbus
CRICOS Code: 08530G

Our programs in Business Administration are designed to provide a strong foundation in appropriate business knowledge, understanding, skills and attitudes for successful careers as managers of organisations including private sector business, not-for-profit, government and public sector entities. Flinders Business Schooll’s teaching philosophy and small class sizes ensure that you can really engage with your teacher, while getting to know your fellow students.

Industry experience:
Students may have the opportunity to undertake an industry placement or project.

STUDY PROGRAM

MBA specialisations include:

> Health or Finance

TAKE THE LEAD IN HEALTH
The combined degree of Master of Business Administration/ Master of Health Administration prepares students to investigate advanced issues in health management with a strong foundation of business knowledge. This course prepares students for a successful career as a manager in the private, not-for-profit, government and public sectors. The course prepares graduates for entry to the Australasian College of Health Service Management and assists medical practitioners to enter the Royal Australasian College of Medical Administrators.
CHEMISTRY
Master of Science (Chemistry)

> Course length: 2 years full-time
> Intake: Semester 1 + Semester 2
> 2018 fees: AUD$30,000

* Students with a Bachelors degree in the same discipline may be eligible for a 1.5 year full-time program.

Entry requirements: Applicants must normally hold an approved Bachelor's degree or equivalent in a major in Chemistry or a closely related discipline from an approved institution. The Master of Science is not available to students who hold an Honours degree in the same discipline. A knowledge of at least second year chemistry is assumed. The Faculty Board may, under certain circumstances and subject to specific conditions, admit others who can show evidence of fitness for candidature.

The Master of Science (Chemistry) is designed for students with a chemistry rich background. The course builds on a student’s existing chemistry knowledge with research and professional skills to investigate, analyse and synthesise complex information, problems, concepts and theories in the systematic development of solutions to complex problems. The Masters award provides graduates with not only the practical and theoretical aspects of chemistry, but also an understanding of professional and ethical responsibilities and an awareness of social, economic, cultural and environmental aspects of chemistry in a global community. Projects and coursework have been designed to address topical concerns in industry and society, preparing graduates for further advancement in a research degree or employment in chemistry-related fields.

STUDY PROGRAM
This course contains both coursework and research components with a research project. This award is flexible and gives students the opportunity to select coursework topics from a range of disciplines and elective topics in areas including nanotechnology, clean technology, polymer science, and ethics, and as well as in various branches of chemistry.

Students will undertake advanced theoretical topics as well as gaining exposure to advanced research skills before undertaking a research project.

CAREER OUTCOMES
Chemistry graduates may start careers as Analysts, Research Chemists, and may be employed in the wine, pharmaceutical, paint, mining, petroleum and automotive industries.

CHEMISTRY
Master of Science (Chemistry)

> Course length: 2 years full-time
> Intake: Semester 1 + Semester 2
> 2018 fees: AUD$30,000

* Students with a Bachelors degree in the same discipline may be eligible for a 1.5 year full-time program.

Entry requirements: Applicants must normally hold an approved Bachelor’s degree or equivalent in a major in Chemistry or a closely related discipline from an approved institution. The Master of Science is not available to students who hold an Honours degree in the same discipline. A knowledge of at least second year chemistry is assumed. The Faculty Board may, under certain circumstances and subject to specific conditions, admit others who can show evidence of fitness for candidature.

The Master of Science (Chemistry) is designed for students with a chemistry rich background. The course builds on a student’s existing chemistry knowledge with research and professional skills to investigate, analyse and synthesise complex information, problems, concepts and theories in the systematic development of solutions to complex problems. The Masters award provides graduates with not only the practical and theoretical aspects of chemistry, but also an understanding of professional and ethical responsibilities and an awareness of social, economic, cultural and environmental aspects of chemistry in a global community. Projects and coursework have been designed to address topical concerns in industry and society, preparing graduates for further advancement in a research degree or employment in chemistry-related fields.

STUDY PROGRAM
This course contains both coursework and research components with a research project. This award is flexible and gives students the opportunity to select coursework topics from a range of disciplines and elective topics in areas including nanotechnology, clean technology, polymer science, and ethics, and as well as in various branches of chemistry.

Students will undertake advanced theoretical topics as well as gaining exposure to advanced research skills before undertaking a research project.

CAREER OUTCOMES
Chemistry graduates may start careers as Analysts, Research Chemists, and may be employed in the wine, pharmaceutical, paint, mining, petroleum and automotive industries.

“Studying at Flinders University taught me a lot. As someone who was educated in China, we used to be taught what to think, not how to think, and studying at Flinders University liberalized my mind quite a bit. I learned how to think. The staff were fantastic and the campus was great.”

Mr Junling Liu is the ex-CEO and Co-Founder of YiHaoDian, China’s largest online retailer, graduate of Flinders Business School MBA and the 2012 Austrade Australia China Alumni Award recipient for Entrepreneurship.

Junling Liu
Master of Business Administration graduate

CHRONIC CONDITION MANAGEMENT
Graduate Certificate in Chronic Condition Management; Graduate Diploma in Chronic Condition Management; Master of Public Health (Chronic Condition Management)

> Course length: 6 months full-time
> Intake: Semester 1 + Semester 2
> 2018 fees: AUD$15,250

Entry requirements: Bachelor degree or equivalent in a relevant field from an approved tertiary institution. Applicants may be admitted directly into the Masters program if they can show evidence of two years’ relevant professional experience.

Note: As per Australian Government regulations, courses that have a placement involving contact with children, young people and/or vulnerable adults, will require students to undergo an Offender History Record Check prior to placement.

The postgraduate programs in Chronic Condition Management aim to meet the extended professional development needs of graduates involved in the provision of policy, planning or delivery of services to people with chronic physical or mental health conditions. These courses seek to offer you an understanding of the core principles and skills involved in developing and implementing self-management enhancing programs in diverse settings for health professionals and service users.

STUDY PROGRAM
Some of the topics that may be undertaken as part of these programs include:
- Chronic Conditions Management for Specific Conditions, Contexts or Populations
- Managing Chronic Conditions: Self-Management and Behaviour Change
- Managing Chronic Conditions: Self-Management Support Approaches
- Implementing Change in Healthcare Systems Supporting Chronic Condition Management
- The Person’s Experience of Self-Management

CAREER OUTCOMES
With growing demand for health services to address chronic condition management in more systematic ways, graduates of this program are highly valued by employers because of their specialisation knowledge and focus in the area. Graduates are suitable for careers in a wide range of chronic condition management roles. Many become dedicated chronic disease coordinators or move into more focussed project and service roles in this growing area. For students who are already in health professional roles, this program offers greater opportunity for promotion and the knowledge in which to lead system change initiatives.

FURTHER STUDY
The courses articulate with sequentially developed topics that allow progression through the awards.

CLINICAL EDUCATION
Graduate Certificate in Clinical Education; Graduate Diploma in Clinical Education; Master of Clinical Education

> Course length: 6 months full-time
> Intake: Semester 1 + Semester 2
> 2018 fees: AUD$15,250

Entry requirements: A Bachelor degree or equivalent qualification in a health related area. Admission to the Masters requires a Bachelor degree or equivalent qualification in a health related area and at least 2 years of work experience in a relevant clinical area.

The articulated program in Clinical Education is an emergent specialty field of education characterised by a symbiotic relationship between the learner, an experienced clinical educator and the health service. These courses are suitable for educators in both clinical and academic settings and will provide health professionals with advanced knowledge to deliver clinical education in health service settings. In addition, students undertaking the Masters program will be able to contribute to this specialist body of knowledge by undertaking a piece of educational research.

STUDY PROGRAM
Topics undertaken may include:
- Symbiotic Clinical Education for the Health Professions
- Assessment of Learning for the Health Professions
- Reflective Learning and Teaching
- Leadership and Change for the Health Profession
- Research Skills in Clinical Education
- Research Project in Clinical Education (Masters)

CAREER OUTCOMES
Graduates are able to contribute to the education profession in today’s dynamic and demanding health service settings through new and innovative approaches to clinical education. Graduates are suitable for careers in clinical teaching in the government and private health sectors.

FURTHER STUDY
The courses articulate with sequentially developed topics that allow progression through the awards.
CLINICAL REHABILITATION
Graduate Certificate in Clinical Rehabilitation; Graduate Diploma in Clinical Rehabilitation: Master of Clinical Rehabilitation

> Course length: Graduate Certificate: 6 months full-time
Graduate Diploma: 1 year full-time
Masters: 1.5 years full-time

> 2018 fee: Graduate Certificate: AUD$18,250
Graduate Diploma: AUD$30,000 Masters: AUD$30,500

> English requirements: IELTS: 6.5

> Intake: Semester 1 • Semester 2

> Opportunity for industry experience

Entry requirements: Graduate Certificate requires a bachelor degree or equivalent in a health-related field. Graduate Diploma/ Masters requires a bachelor degree or equivalent in a health-related field and at least two years relevant work experience in a relevant clinical area.

Note: As per Australian Government regulations, courses that have a placement involving contact with children, young people and/or vulnerable adults, will require students to undergo an Offender History Record Check prior to placement.

These articulated courses aim to provide individuals from any health professional background the opportunity to enhance their knowledge and skills in the area of clinical rehabilitation. In addition to gaining an understanding of the principles and practice of clinical rehabilitation, students also have the opportunity of studying in an area relevant to their field of clinical practice. Students also receive training in research methods and can develop either research expertise or advanced practice skills in the area of clinical rehabilitation and apply this to a specific project.

The Research stream of the Master of Clinical Rehabilitation allows students to understand principles and practice of clinical rehabilitation, receive training in research methods, and undertake a significant research project in the form of a thesis.

Industry experience: Students can participate in a clinical placement.

STUDY PROGRAM
Topics undertaken may include:
> Early Rehabilitation Following a Stroke
> Principles of Clinical Rehabilitation
> Rehabilitation of Degenerative Neurological Disorders

CAREER OUTCOMES
Graduates can work in both public and private health care organisations. Potential roles include clinical nurse educator, rehabilitation advisor, rehabilitation consultant, rehabilitation counsellor and health coordinator (rehabilitation). Potential organisations include hospitals, rehabilitation centres, community health centres, schools and mental health services. They may also work in teaching, managerial or research positions.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/crc
CRICOS Code: Graduate Certificate – 059067D, Graduate Diploma – 060408A, Masters – 060408M

COGNITIVE BEHAVIOUR THERAPY
Graduate Certificate in Cognitive Behaviour Therapy; Graduate Diploma in Cognitive Behaviour Therapy: Master of Cognitive Behaviour Therapy

> Course length: Graduate Certificate: 2 years full-time
Graduate Diploma: 2 years full-time
Masters: 2 years full-time

> 2018 fee: Graduate Certificate: AUD$30,500
Graduate Diploma: AUD$30,500 Masters: AUD$30,500

> English requirements: IELTS: 7.0 (R7 • W7 • L7 • S7)

> Intake: Semester 1 • Semester 2

> Opportunity for industry experience

Entry requirements: Applicants must normally hold an approved undergraduate degree or equivalent in a health-related area – e.g. behavioural science, counselling, medicine, nursing, occupational therapy, psychology or social work.

It is preferable that prospective students have experience working in a related context in working that complements the inherent course requirements of the CBT postgraduate programs. Experience working with people in a health related environment is advantageous and will support successful progression in this applied postgraduate course.

Note: As per Australian Government regulations, courses that have a placement involving contact with children, young people and/or vulnerable adults, will require students to undergo an Offender History Record Check prior to placement.

Flinders University’s cognitive behaviour therapy (CBT) programs provide you with clinical competencies and research skills in CBT for high prevalence psychological disorders. You will gain clinical training opportunities through industry placements modelled around a clinical supervision framework. You will have the opportunity to develop knowledge in areas such as comorbid mental health disorders, high prevalence psychological disorders, and gambling disorders; and develop skills in areas such as behavioural activation and motivational interviewing.

The courses are industry new allied health graduates and health professionals who are committed to ongoing professional development and personal growth using accountable and ethical practice principles.

STUDY PROGRAM
Topics studied may include:
> Low-Intensity Cognitive Behaviour Therapy for Psychological Disorders
> Fundamentals of Clinical Practice
> Theory and Models of Cognitive Behaviour Therapy
> Cognitive Behaviour Therapy for Psychological Disorders

CAREER OUTCOMES
Graduates of this program are competent and equipped to contribute and improve mental health service delivery because of their specialised knowledge and clinical competencies in the area of cognitive behaviour therapy (CBT), high prevalence psychological disorders and stepped care models of mental health care. Graduates can work in both private and public health care organisations and are trained to work in a range of primary mental health care roles. Graduates who are already in health professional roles are well placed to seek promotional opportunities in service delivery, clinical supervision and leadership.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/cbt

COMPUTER SCIENCE
Master of Science (Computer Science)

> Course length: 2 years full-time*

> Intake: Semester 1 • Semester 2

> Professional accreditation

* Students with a Bachelors degree in the same discipline may be eligible for a 1.5 year full-time program.

Entry requirements:
Applicants must normally hold an approved Bachelor’s degree or equivalent in Computer Science, Information Technology, ICT-based engineering or a closely related discipline from an approved institution. Applicants with an approved degree in behavioural science or psychology, which includes a major in Artificial Intelligence or Computer Science, are also eligible to apply. A knowledge of second year information technology is assumed. The Faculty Board may under certain circumstances, and subject to specific conditions, admit others who can show evidence of fitness for candidates. The Master of Science is not available to students who hold an Honours degree in the same discipline.

The Master of Science (Computer Science) is designed for students with a computer science, software/computer systems engineering, information technology, information systems or an equivalent computing rich background. The course builds on a student’s existing computer science, research and professional skills. Flexibility is built into the course and students have the opportunity to choose from a variety of elective topics.

The Masters provides graduates with not only the practical and theoretical aspects of computer science, but also an understanding of professional and ethical responsibilities and an awareness of social, economic, cultural and environmental aspects of computer science in a global community. Projects and coursework have been designed to address topical concerns in industry and society preparing graduates for further enrolment in a research higher degree or employment in a computing related field.

The course is offered at Flinders’ new Tonsley Campus, a state-of-the-art, 18,000 square metre facility that is the heart of South Australia’s new industrial future. Flinders will be part of this exciting new collaborative and high-value industry, education and residential precinct at Tonsley – and serves as a remarkable site for experiential learning, social innovation and inspiration. Flinders at Tonsley is a place where students interact with business, and where business interacts with researchers in the areas of engineering, medical devices and nanoscale technologies to make the new products and processes of the 21st century.

Professional accreditation: This program is accredited by the Australian Computer Society at the Professional level. Courses accredited at this level by the Australian Computer Society are recognised internationally under the Seoul Accord.

STUDY PROGRAM
Topics you may study include:
> Standards, Ethics and Compliance
> Project Management and Innovation
> Intelligent Systems

CAREER OUTCOMES
The information technology and science departments of major organisations in telecommunications, aerospace and defence, government, higher education institutions and private organisations are all in the market for computer science graduates. Graduates gain positions as computer programmers, software developers, business analysts, and in database development and administration, hardware support, project management, sales and marketing, telecommunications, web development and security.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/mscsc
CRICOS Code: 07334D
DIGITAL PRODUCTION FOR ENTERTAINMENT DESIGN
Graduate Certificate in Digital Production for Entertainment Design, Master of Digital Production for Entertainment Design

Entry requirements: Bachelor degree or equivalent from an approved tertiary institution. In addition, an application form and portfolio are required, including examples of creative work, for one or more of the positions in the creative team.

Offered in collaboration with CDW Studios, this high-level training program is designed specifically for the rapidly changing commercial world of visual effects and all areas of entertainment design. This innovative new course operates in a production style environment and is based around students working in small creative teams throughout the course to develop their own intellectual property from idea development through to design and implementation of complex story and animation projects. You will develop knowledge and skills in the latest industry techniques and technologies, and will have the opportunity to develop networks and contacts with leading industry professionals.

Industry experience: The course is taught by currently practicing industry professionals who have worked at major companies such as Wizards of the Coast, Blizzard Entertainment, Universal Pictures, Disney and LEGO.

STUDY PROGRAM
In the first semester of year one you are provided with training on how to work within a creative team and a production ‘pipeline’. This involves each team developing a creative solution to a brief and producing a short animated story as the end product. In the second semester of year one, students will continue to work within small creative teams throughout the course to develop their own intellectual property from idea development through to design and implementation of complex story and animation projects. You will develop knowledge and skills in the latest industry techniques and technologies, and will have the opportunity to develop networks and contacts with leading industry professionals.

CAREER OUTCOMES
Graduates of this course will be able to obtain employment in a range of organisation structures including creative and technical roles. Potential roles include: production manager, project manager, creative producer, technical producer, technical director, writer, story artist, character designer and technical artist.

Further course information: flinders.edu.au/courses/postgrad/hip
CRCOS Code: Graduate Certificate – 085909E, Masters – 085901D

DISASTER HEALTH CARE
Graduate Certificate in Disaster Health Care, Graduate Diploma in Disaster Health Care, Master of Disaster Health Care

Entry requirements: Applicants must normally hold an approved bachelor degree or equivalent qualification in a health profession, and have at least two years’ professional experience in the health care sector following completion of the degree or equivalent qualification. However, the Faculty Board may, under certain circumstances and subject to specific conditions, admit others who can show evidence of fitness for candidature. Credit may be granted for comparable prior studies.

The Disaster Health Care program is designed to provide students who are working in health care, whatever their professional background, with the opportunity to advance their theoretical and practical knowledge and skills in disaster health management and response and to apply these in a range of disaster situations.

The course builds on students’ current workplace and/or disaster response training and experience and allows them to proceed, if they wish, to further graduate-level coursework.

The program was developed in collaboration with the National Critical Care and Trauma Response Centre (NCCTRC) and is offered in external study mode through Flinders University.

STUDY PROGRAM
Topics studied as part of this program include:
> Introduction to Disaster Health
> Health Management and Planning
> Clinical Decision Making in Disaster Health Care
> International Disaster Practice

CAREER OUTCOMES
Graduates of the Master of Disaster Health Care will have the theoretical and operational knowledge to enhance their employability with government and non-government disaster relief agencies. Some graduates will be prepared for involvement in international response to disaster, including resilience building and mitigation in the recovery phase. In addition the course will offer clinicians the opportunity to increase their knowledge of disaster preparedness and awareness in the domestic context, to better prepare them to respond to a disaster. This is a unique program to the region and graduates will be well placed to gain or advance in employment as a result of completing the course.

Further course information: flinders.edu.au/courses/postgrad/icda
CRCOS Code: 090299B

DEVELOPMENT ADMINISTRATION
Graduate Certificate in Development Administration

Entry requirements: Bachelor degree or equivalent from an approved tertiary institution.

The Graduate Certificate in Development Administration is designed to provide participants with a comprehensive knowledge of developmental issues and to enhance their capabilities and skills necessary to plan, implement, manage and evaluate development programs. In this context, it is a basic development qualification with direct relevance to public sector, international development agencies and non-government organisations. As the first step in the Graduate Program in Public Administration, the Graduate Certificate provides a basic entry point to more advanced studies up to masters level, as well as self-contained mid-career development options.

Industry experience: Students have the opportunity to undertake an internship.

STUDY PROGRAM
You will study the following topic, plus electives:
> Development Administration

Elective topics cover aspects of Development Administration, including issues relating to policy, sustainability, international development, governance, and management.

CAREER OUTCOMES
The program provides a conceptual and practical framework for individuals wishing to proceed with careers in government, international development agencies and various non-governmental organisations. Potential roles include sustainable development officer, regional development manager, strategic analyst, project officer, international policy advisor and public relations officer.

FURTHER STUDY
The Graduate Certificate in Development Administration articulates with the Graduate Diploma in Public Administration and the Master of Public Administration.

Further course information: flinders.edu.au/courses/postgrad/icda
CRCOS Code: 090299B

DISABILITY STUDIES
Graduate Certificate in Disability Studies; Master of Disability Policy and Practice

Entry requirements: Graduate Certificate: Bachelor degree, diploma or equivalent qualification in a relevant area from an approved tertiary institution. Masters - Full Program Entry Level: An approved Bachelor degree or equivalent qualification in a relevant area related to disability, Advanced Program Entry Level: An approved Bachelor degree in Disability from an approved tertiary institution, or an approved Bachelor degree of four or more years duration in an area closely related to Disability and two years of relevant professional experience, an Honours degree in Disability or a closely related discipline from an approved tertiary institution or a Graduate Certificate in Disability or a closely related discipline.

Disability professionals play an important role in assisting people with disabilities to participate in the economic and social mainstream of society and be seen as valued members of their local communities. The interests of disability professionals are broad, incorporating community rehabilitation, health, education, technology, advocacy, recreation, community living, employment and arts. Moreover, disability professionals are able to apply their skills and knowledge to the diverse needs of people with developmental or acquired disabilities.

STUDY PROGRAM
Topics available include:
> Communication Difficulties
> Autism Spectrum Disorder
> Intellectual Disability
> Transition from School to Adult Life
> Design and Evaluation of Disability Programs
> Leisure, Disability and Diversity
> Perspectives on Ageing and Disability
> Disability: Individual, Family and Society

CAREER OUTCOMES
This is a professionally orientated program designed to meet the needs of practitioners working in education, health, and community services and of teachers seeking specialised education in this field. Graduates are suitable for careers in a wide variety of fields supporting people with disabilities. Disability Studies graduates can work as disability officers, service coordinators, welfare officers, social and community workers, councillors, administrators, managers and employment placement consultants. Potential employers include disability support services, schools, government and community agencies worldwide.

Further course information: flinders.edu.au/courses/postgrad/ds
The Master of Education and specialisations seek to provide an introduction to the traditions of thought and analysis used to discuss and illuminate matters of educational policy and practice. It gives advanced insights into theoretical and practical matters in education in such a way as to improve professional decision making. You will gain an opportunity to specialise in educational topics of particular value or interest to you, and will be given an introduction to the variety of educational research methods and be able to compare their effectiveness.

Vision Impairment is designed for practising teachers, school leaders and advisory personnel who work with students with vision impairment, those who have a general interest in developing their knowledge in this area and those who aspire to enter this specialisation.

The Cognitive Psychology and Educational Practice specialisation will help you develop an understanding of the cognitive psychology of learning and investigate how this can be applied to problems that arise in learning and teaching.

Postgraduate programs in Gifted Education are dynamic and are regularly revised and updated in the light of current research, new publications and contemporary practices. The courses are designed to prepare educators for professional work and leadership in Gifted Education.

International Baccalaureate programs will enhance your teaching in International Baccalaureate schools. Flinders was the first tertiary institution in the world to be accredited to offer a postgraduate award for school educators teaching in the International Baccalaureate Middle Years Program (IBMYP). The Languages Education specialisation is the only course of its kind currently offered in South Africa. It is not language specific, it will enable you to gain broad perspectives in the field of languages education, as well as allow you in-depth exploration of its theory and practice.

The Leadership and Management program is especially suitable for current and future human resource managers, knowledge managers, school principals and departmental officers, policy developers, vocational education sector managers, and leaders of university academic and administration units.

Special Education is the joint responsibility of special and regular teachers working closely together with parents, and in multidisciplinary teams with other professionals such as school psychologists and speech/language pathologists. Education appropriate to each child’s level of development and in the least restrictive environment is a fundamental principle underlying special education.

Educational Research, Evaluation and Assessment combines the study of research design and methods, evaluation and assessment with a research focus on major contemporary education policy issues. The program is designed for people pursuing research and academic careers in education, social science and human services.

Wellbeing and Positive Mental Health is a new and growing area of the curriculum for teachers and educators, as evidenced by the current and emerging education policy and curriculum frameworks at international, federal, state and community levels.

The Graduate Certificate in Education is intended for people currently employed in education, special education or education management, and for those who have an interest in developing their knowledge and practice in these areas. It provides you with an introduction to knowledge and skills in your area of interest, with a focus on understanding and changing practice.

The highly regarded Master of Education and specialisations are aggregated into a flexible single program, greatly enhancing the potential for students to create individual programs to suit their interests and thus shape their own educational pathways. These specialisations reflect new areas of strength within the School of Education and a commitment to be responsive to the professional needs of the education community. The structure also offers a high level of quality research training.

Entry requirements: Bachelor degree or equivalent in an approved field of study. Some specialisations have additional requirements, such as a degree in a relevant field and/or relevant employment experience.

Study Mode: Internal/External
- Graduate Certificate
- Graduate Certificate in Education (Languages Education)
- Graduate Certificate (Leadership & Management)
- Graduate Certificate (Special Education)
- Masters: Master of Education
- Masters (Cognitive Psychology and Educational Practice)
- Masters (Gifted Education)
- Masters (Leadership and Management)
- Masters (Special Education)
- Master (Wellbeing and Positive Mental Health)

Internal only
- Masters (International Baccalaureate)
- Masters (Educational Research, Evaluation and Assessment)

External only
- Graduate Certificate (Cognitive Psychology & Educational Practice)
- Graduate Certificate (Higher Education)
- Graduate Certificate (Internationally Baccalaureate Middle Years)
- Graduate Certificate (Language Education)
- Graduate Certificate (Vision Impairment)
- Graduate Certificate (Gifted Education)
- Graduate Certificate (Wellbeing and Positive Mental Health)

Graduates are suitable for careers in a variety of positions ranging from work as teachers in school classrooms, school coordinators and principals, curriculum and policy advisors in departments of education and as advisors to government departments and other policy makers. Please note that the Master of Education courses do not lead to teacher registration. For a career as a teacher, see under Teaching.

CAREER OUTCOMES

STUDY PROGRAM
Students undertaking the Graduate Certificate in Education may change focus on a number of specialisations, including:
- Cognitive Psychology and Educational Practice
- Gifted Education
- Higher Education
- International Baccalaureate Middle Years Program (IBMYP)
- Languages Education
- Leadership and Management
- Vision Impairment
- Wellbeing and Positive Mental Health

Masters students complete an in-depth coursework program either in Education or chosen from the following streams:
- Cognitive Psychology and Educational Practice
- Educational Research, Evaluation and Assessment
- Gifted Education
- Higher Education
- Languages Education
- International Baccalaureate
- Leadership and Management
- Vision Impairment
- Wellbeing and Positive Mental Health

CAREER OUTCOMES

Graduates are suitable for careers in a variety of positions ranging from work as teachers in school classrooms, school coordinators and principals, curriculum and policy advisors in departments of education and as advisors to government departments and other policy makers. Please note that the Master of Education courses do not lead to teacher registration. For a career as a teacher, see under Teaching.

FURTHER STUDY
The Graduate Certificate and Master of Education articulate, with sequentially developed topics that allow progression through the two awards. Students who undertake a substantial research component with the Master of Education may be considered for further study at the PhD or Doctor of Education level.

FURTHER COURSE INFORMATION >> flinders.edu.au/courses/postgrad/ed

CRICOS Code:
- Graduate Certificate (Cognitive Psychology and Educational Practice) – External
- Graduate Certificate in Education – 023986A
- Graduate Certificate (Higher Education) – External
- Graduate Certificate (Languages Education) – External
- Graduate Certificate International Baccalaureate – External
- Graduate Certificate (Leadership & Management) – 058441G
- Graduate Certificate (Special Education) – 093134C
- Graduate Certificate (Vision Impairment) – External
- Graduate Certificate (Gifted Education) – External
- Graduate Certificate (Wellbeing and Positive Mental Health) – External
Flinders University offers a range of engineering courses that are designed to prepare students for a variety of career paths in the field. These courses are accredited by Engineers Australia and are aimed at providing students with the skills and knowledge necessary to pursue professional engineering status.

### Engineering (Biomedical)

**Master of Engineering (Biomedical)**

- **Course length**: 2 years full-time
- **Intake**: Semester 1, Semester 2
- **Opportunity for industry experience**: Professional accreditation

The course meets the needs of people who already have an undergraduate degree with expertise in electronic engineering and would like to broaden their expertise or specialise in the field of Biomedical Engineering as practising Engineers. In addition, the coursework Masters can, subject to meeting a credit average in the course, provide a qualify qualifying pathway into a Biomedical Engineering PhD for students who have not completed an undergraduate award in that area.

The course is offered at Flinders' new Tonsley Campus, a state-of-the-art, 18,000 square metre facility that is at the heart of South Australia's industrial future. Flinders is part of this exciting new collaborative and high-value industry, education and residential precinct at Tonsley - and serves as a remarkable site for experiential learning, social innovation and inspiration. Flinders at Tonsley is a place where students interact with business, and where business interacts with researchers in the areas of engineering, medical devices and nanoscale technologies to make the new products and processes of the 21st century.

**Industry experience**: 12 week industry placement.

**Professional accreditation**: This program is fully accredited by Engineers Australia at the level of professional engineer. Professional engineering courses accredited by Engineers Australia are recognised internationally under the Washington Accord.

**Study program**

**Topics studied may include:**
- Physiological Measurement
- Standards, Ethics and Compliance
- Biomechanics
- Biomedical Instrumentation

**Career outcomes**

Graduates work in a variety of areas including the design and production of diagnostic and therapeutic medical equipment in hospitals, devices to assist in home-based health care and rehabilitation and sensory and control systems. Potential roles include biomedical engineer, medical device assurance, clinical support specialist, field service engineer, pathology and specialist product educator/biomedical.

**Further course information**

[flinders.edu.au/courses/postgrad/eb](http://flinders.edu.au/courses/postgrad/eb)

CRICOS Code: 05942K


### Engineering (Civil)

**Master of Engineering (Civil)**

- **Course length**: 2 years full-time
- **Intake**: Semester 1, Semester 2
- **Opportunity for industry experience**: Professional accreditation

The Master of Engineering (Civil) is an accredited postgraduate qualification in Civil Engineering. It will prepare you for a career in planning, design and maintenance of infrastructure such as transport and the mining industries.

Civil engineers plan, design, build and maintain a wide variety of physical infrastructure such as bridges, buildings, airports, roads, railways, ports, mines, water and wastewater supply, treatment and reuse systems. They also help to maintain sustainable natural environments. The solutions developed by civil engineers must take into consideration social, environmental and financial constraints.

The course has been designed to provide graduates with:
- a strong foundation in both the theoretical and practical aspects of Civil Engineering
- an awareness of social, economic, cultural and environmental aspects of Civil Engineering
- an ability to critically analyse and evaluate information and solve civil engineering related problems

**Industry experience**: The course includes a work experience component where student will get hands on real world industry experience in Civil Engineering practice.

**Professional accreditation**: This program is provisionally accredited by Engineers Australia at the level of professional engineer. Full accreditation is normally granted when the first cohort of students graduate from the program. Professional engineering courses accredited by Engineers Australia are recognised internationally under the Washington Accord. Graduates meet the academic requirements for attaining chartered professional engineering status.

**Study program**

This course covers the four traditional sub-disciplines of Civil Engineering, Geotechnical, Structural, Transport and Water Engineering, with the flexibility to choose specialist topics that will enhance knowledge within a particular Civil discipline. This flexibility is complemented by a major thesis (subject to receiving a credit average) or project that allows students to explore a particular aspect of civil engineering in depth. The course also includes a work experience component where students will get hands on real world industry experience in Civil Engineering practice.

**Career outcomes**

Civil engineers work closely with architects, planners and the community to ensure that what is constructed is what is needed. And unlike many disciplines, the fruits of civil engineering often last a very long time. Civil engineering graduates are in great demand with career destinations including building and construction, transport and the mining industries.

**Further course information**

[flinders.edu.au/courses/postgrad/engcivil](http://flinders.edu.au/courses/postgrad/engcivil)

CRICOS Code: 091861A

### Engineering (Electronics)

**Master of Engineering (Electronics)**

- **Course length**: 2 years full-time
- **Intake**: Semester 1, Semester 2
- **Opportunity for industry experience**: Professional accreditation

The world of instrumention and control is rapidly evolving to include applications that are both large scale and nanosecond. Career paths are wide ranging in this fast moving field, and include both applied and theoretical research.

**Entry requirements**: For all prerequisites and entry requirements please refer to: [flinders.edu.au/courses/postgrad/esi](http://flinders.edu.au/courses/postgrad/esi)

**FURTHER COURSE INFORMATION**

[flinders.edu.au/courses/postgrad/esi](http://flinders.edu.au/courses/postgrad/esi)

CRICOS Code: 061292G

CAREER OUTCOMES

Potential roles include electronics engineer, broadcast engineer, project coordinator, test engineer, regulatory analyst and scientist. There are many employment opportunities in some of the fastest growing areas in defence, medicine, telecommunications, building, manufacturing, construction and mining.

**Further course information**

[flinders.edu.au/courses/postgrad/esi](http://flinders.edu.au/courses/postgrad/esi)

CRICOS Code: 061292G
Materials represents an important component of many technological products and the engineering of materials connects to a variety of research areas including nanotechnology, biomedical engineering, mechanical engineering, chemical sciences, electrical engineering and civil engineering. This Masters program provides a broad extension to a student’s undergraduate study focussing on the selection, production and behaviour of practical materials used in engineered products. Materials engineers also look closely at materials failure—fracture, corrosion, and non-destructive testing, and are generally interested in solid materials as they are primarily the materials used for manufacture. Materials engineering involves investigating, including recycling, and generally involves using materials in bulk.

Flinders University has a research strength in Materials Engineering. Our leading researchers use well-equipped laboratories at Tonsley such as Advanced Materials Laboratory, Solid Mechanics and Materials Laboratory, and Large Scale Material Testing Laboratory together with the Centre for NanoScience, Science and Technology, and materials characterization facilities located at Bedford Park provide an excellent research environment for advanced research activities in the area of Materials Engineering.

**STUDY PROGRAM**

This program offers a unique combination of advanced areas such as Materials Selection in Design, Metal Forming, Nanomaterials, Polymers, Biomaterials, Corrosion, Fatigue & Fracture, Characterisation Techniques, Organic Synthesis, and Materials for Civil, Electrical and Optical Applications. The course is designed to present practical aspects of materials engineering. Subject to receiving a credit average students will also be able to undertake research project topics which enable them to develop their research skills be developing solutions to large and complex problems. These skills are the foundation for further postgraduate work at the PhD level.

**CAREER OUTCOMES**

Materials Engineers are able to find jobs in almost all fields in which technology is developing at a great rate of career opportunities to work as a metallurgist, process engineer, corrosion engineer, polymer engineer, ceramist, quality control engineer, and surface coatings scientist.

**FURTHER COURSE INFORMATION**

CRICOS Code: 09491J

---

**ENGINEERING (MATERIALS)**

**Master of Engineering (Materials)**

Entry requirements: Applicants normally must hold the Flinders University Graduate Diploma in Engineering Science (specialisation M1-M2) with an average grade of credit or higher, or a relevant Bachelor of Engineering, Bachelor of Computer Engineering, Bachelor of Engineering Science with an average grade of credit or higher, or an equivalent overseas qualification.

Opportunities to work as a metallurgist, process engineer, corrosion and solid mechanics scientist are available in almost all fields in which technology is developing at a great rate of career opportunities to work as a metallurgist, process engineer, corrosion engineer, polymer engineer, ceramist, quality control engineer, and surface coatings scientist.

---

**ENGINEERING SCIENCE**

**Graduate Diploma in Engineering Science**

Entry requirements: The admission requirements for the award are either an engineering degree, a science degree, a mathematics/science degree (for later articulation to the Master of Engineering (Biomedical) which must include study in biology, chemistry/materials and human physiology/computer science) or information technology degree (for later articulation to the Master of Engineering (Electronics) which must include study in either programming or digital electronics); a chemical sciences degree (for later articulation to the Master of Engineering (Materials) which must include study in chemistry/materials); an Australian TAFE Diploma or Advanced Diploma (AQF Level 5) qualification in an appropriate field plus 7 years relevant work experience; or an equivalent international qualification.

In addition, whatever qualification is held, students are expected to be able to demonstrate previous study or recognised prior learning in communication and planning skills, mathematics (equivalent to first-year university mathematics) and science (equivalent to university undergraduate topics in chemistry and physics). Some basic knowledge of other relevant sciences will be assumed.

The Graduate Diploma in Engineering Science has four specialisations including Biomedical, Civil, Electronic and Materials Engineering. This program can be used as pathway to the Flinders Master of Engineering (Biomedical), Master of Engineering (Civil), Master of Engineering (Electronics) and Master of Engineering (Materials) for graduates of science and non-engineering disciplines.

To progress to these Masters degrees you will need to receive at least a credit average for studies. You will study both the theoretical and practical aspects of engineering, building on your previous experience and knowledge.

**STUDY PROGRAM**

Biomedical Specialisation may include topics such as:

- Electronics, Human Physiology, Microprocessors
- Civil Specialisation may include topics such as:
  - Civil Engineering Design, Engineering Mechanics, Engineering Geology and Geomechanics
  - Electronics Specialisation may include topics such as:
    - Automation and Industrial Control Engineering, Programming, Analysis of Engineering Systems
  - Materials Specialisation may include topics such as:
    - Solid Mechanics, Mechanics and Structures, Engineering Physics and Materials

**CAREER OUTCOMES**

Graduates can work in an engineering related field where the skills and knowledge of engineering fundamentals and the ability to communicate with engineering professionals are needed.

**FURTHER COURSE INFORMATION**

CRICOS Code: 077361E

---

**ENGINEERING SCIENCE**

**Master of Engineering Science (Specialisation)**

Entry requirements: For all prerequisites and entry requirements on this course refer to.

Funders University’s postgraduate programs in engineering are multi-disciplinary in approach and provide you with access to the latest technical resources.

This course allows students to undertake a Specialisation in Biomedical, Civil, Electronic and Electrical Materials, Mechanical or Software Engineering.

This program builds on the knowledge a student has gained from their first degree by providing a focus in a wide range of foundation and advanced course related to engineering. The course includes a major project in which students study an area of interest. The course is flexible allowing students to have studied similar material before to modify their program of study.

Professional accreditation: This course is not accredited but students who have completed at least twelve months with a credit average may transfer to the relevant accredited Master of Engineering (Biomedical), Master of Engineering (Civil), and Master of Engineering (Electronics).

**BIOMEDICAL**

The Master of Engineering Science (Biomedical) equips students with the skills to investigate, plan, design, manufacture and maintain medical and scientific devices.

**SOFTWARE**

The Master of Engineering Science (Software) equips students with the skills to investigate, plan, design, manufacture and maintain information technology systems and equipment that are used in all aspects of health care.

Throughout the course, there is a strong emphasis on practical skills and teamwork, and graduates often work in multi-disciplinary teams with health professionals and medical specialists in hospitals and public and private sector organisations. They use their professional skills and knowledge in the systematic development of complex systems with particular emphasis on biomedical systems. This includes the design or production of:

- A wide range of sophisticated diagnostic and therapeutic medical equipment systems
- Devices to assist in home-based health care and rehabilitation, including prosthetic and biomechanical devices.

**CIVIL**

Civil engineers develop and maintain a wide variety of physical infrastructure such as bridges, buildings, airports, roads, railways, ports, mines, sites, water and wastewater supply, treatment and reuse systems. They also help to maintain sustainable natural environments.

Civil engineers are able to find jobs in almost all fields in which technology is developing at a great rate of career opportunities to work as a metallurgist, process engineer, corrosion engineer, polymer engineer, ceramist, quality control engineer, and surface coatings scientist.

**SOFTWARE**

Software engineering is a dynamic engineering discipline that is concerned with all aspects of software use, from design and development to maintenance and management. The Master of Engineering Science (Software) equips students with the skills to combine the art and skill of engineering with the power of computer technology. Software engineering develops programs and products that meet the demands of the modern economy.

Graduates will be equipped to work as software designers in areas as diverse as smart cards, mobile commerce and communications, simulators, medical and imaging equipment, internet computing and defence systems.

**FURTHER STUDY**

Master of Engineering (Biomedical), Master of Engineering Science (Electronics), Master of Engineering (Civil), Master of Engineering (Mechanical) and Master of Engineering (Materials) by Research. Doctor of Philosophy.

**FURTHER COURSE INFORMATION**

CRICOS Code: 09491J

---

**ENGINEERING ELECTRONIC**

Electrical engineering is concerned with large scale electrical systems such as power supply, renewable power generation and motors and when electronic technology is typically concerned with small scale, often lower voltage electrical systems such as computer systems, communication networks and integrated circuits. This degree adds to a student’s previous study and covers both types of engineering.

The Master of Engineering Science (Electrical and Electronic) equips students with the skills and knowledge to plan, design and build the electrical and electronic circuitry that is integral to so many high technology applications. Students also have the opportunity to focus on specific areas including renewable technologies such as wind farms, and electrical and diagnostic circuits that are used on ships and submarines and in emission-free vehicles. Electrical and electronic engineers are involved in developing technology used in areas such as automotive, media, communication, medical equipment, robotics, broadband systems and scientific devices.

High demand exists for qualified professional electrical and electronic engineers in areas such as defence, medicine, telecommunications, building, manufacturing and mining.

**MATERIALS**

Materials represents an important component of many technological products and the engineering of materials connects to a variety of research areas including nanotechnology, biomedical engineering, mechanical engineering, chemical sciences, electrical engineering and civil engineering. This course builds on the knowledge a student has gained from their first degree by providing a focus in a wide range of foundation and advanced course related to engineering. The course includes a major project in which students study an area of interest. The course is flexible, allowing students to have studied similar material before to modify their program of study.

Professional accreditation: This course is not accredited but students who have completed at least twelve months with a credit average or higher may transfer to the relevant accredited Master of Engineering (Biomedical), Master of Engineering (Civil), and Master of Engineering (Electronics).

**BIOMEDICAL**

The Master of Engineering Science (Biomedical) equips students with the skills to investigate, plan, design, manufacture and maintain medical and scientific devices.

**SOFTWARE**

The Master of Engineering Science (Software) equips students with the skills to combine the art and skill of engineering with the power of computer technology. Software engineering develops programs and products that meet the demands of the modern economy.

Graduates will be equipped to work as software designers in areas as diverse as smart cards, mobile commerce and communications, simulators, medical and imaging equipment, internet computing and defence systems.

**FURTHER STUDY**

Master of Engineering (Biomedical), Master of Engineering Science (Electronics), Master of Engineering (Civil), Master of Engineering (Mechanical) and Master of Engineering (Materials) by Research. Doctor of Philosophy.

**FURTHER COURSE INFORMATION**

CRICOS Code: 09491J
ENVIRONMENTAL HEALTH
Graduate Diploma in Environmental Health Practice; Master of Environmental Health

> Course length: Graduate Diploma: 1 year full-time
> Masters: 2 years full-time
> Intake: Semester 1 • Semester 2
> Professional accreditation

Entry requirements: Bachelor degree or equivalent with a minimum of one successful semester of full-time study in basic sciences such as chemistry, physics, microbiology, physiology or life sciences.

Note: Some topics in the Graduate Diploma are taught in intensive delivery mode.

Environmental Health is the study of how the environment impacts on our health – the physical, biological, chemical and sociological factors external to us that determine our health and well-being. Environmental health is the branch of public health that is concerned with both environmental and built environment that affect our health, such as water, food, air, buildings and waste. The postgraduate courses in Environmental Health aim to provide you with the professional qualifications to enter or enhance career opportunities in the area of environmental health. This pathway program provides you with advanced knowledge in the theory and application of environmental and environmental health risk assessment.

Professional accreditation: The Graduate Diploma and the Masters have been designed to fit the requirements for Environmental Health Australia (EHA) accreditation, enabling practice across Australia and internationally.

STUDY PROGRAM
Topics may include:
> Environmental Health Concepts
> Human Systems in Environmental Health
> Sustainable Development - Health Issues
> Legislation Relevant to Environmental Health
> Microbiology and Communicable Diseases

CAREER OUTCOMES
Graduates of the Graduate Diploma in Environmental Health Practice will be qualified to practice as EHOs, however some further study may be required for international students to be recognised under their domestic legislation. Graduates of the Masters program will be qualified for employment in both the public and private sector, especially local government, state health departments, private environmental consulting firms and mining companies. Graduates will gain the project management, research, communication and report writing skills that are critical to the senior and specialist roles in environmental health.

FURTHER COURSE INFORMATION >>
flinders.edu.au/courses/postgrad/gdhp
CRICOS Code: Graduate Diploma - 083996C. Graduate Diploma - 039964A. Masters - 008004B

ENVIRONMENTAL MANAGEMENT
Graduate Certificate in Environmental Management; Graduate Diploma in Environmental Management; Master of Environmental Management

> Course length: Graduate Certificate: 6 months full-time
> Graduate Diploma: 1 year full-time
> Masters: 2 years full-time
> Intake: Semester 1 • Semester 2
> Professional accreditation

Entry requirements: Bachelor degree or equivalent qualification from an approved tertiary institution.

Human-environment interactions pose some of the most compelling and fraught challenges of the 21st century (climate change, deforestation, water resources availability, energy consumption, urban expansion, population growth and food security). Understanding these challenges and solving environmental problems requires both knowledge of ecological and physical processes and insight into the cultural, demographic, economic, historical, geographical, political aspects of human-environment connections. Environmental management is therefore complex and requires interdisciplinary approaches to resolving challenges posed by human-environment interactions.

STUDY PROGRAM
The program is international in scope but case study material draws strongly on the experiences of Australia and other countries within the Asia-Pacific region. All three programs combine important theoretical knowledge with the opportunity to complete skill-based topics. There is a large range of option topics to choose from so that programs can be built to suit student’s interests and current or future employment requirements.

CAREER OUTCOMES
Potential positions include policy, research or planning officers and on-ground management. Graduates of the Environmental Management programs are suited to a diverse range of positions across a range of employers, including government, non-government organisations and the private sector.

FURTHER STUDY
The Graduate Certificate in Environmental Management articulates with the Graduate Diploma in Environmental Management and the Master of Environmental Management.

FURTHER COURSE INFORMATION >>
flinders.edu.au/courses/postgrad/egmp
CRICOS Code: Graduate Certificate - 028960C. Graduate Diploma - 039964A. Masters - 008004B

GENDER, DEVELOPMENT AND WOMEN’S STUDIES
Graduate Diploma in Gender and Development; Master of Arts (Women’s Studies)

> Course length: Graduate Diploma: 1 year full-time
> Masters: 2 years full-time
> Intake: Semester 1 • Semester 2
> Professional accreditation

Entry requirements: Bachelor degree or equivalent qualification from an approved tertiary institution.

The Graduate Diploma in Gender and Development is a structured, multidisciplinary program combining Women’s Studies with Politics, Sociology and other disciplines as approaches to the broad issues of gender, development and the rights of people in society. It introduces students to the theoretical and empirical analysis of a wide range of issues and focuses on the development of flexible skills suited to a variety of situations and contexts. The Master of Arts (Women’s Studies) is available in a coursework stream and a research stream. Gender issues shape political, cultural and social institutions, as well as personal identity and relationships. The interdisciplinary field of Women’s Studies reflects the wide scope by including social, cultural and political perspectives.

STUDY PROGRAM
Topics undertaken in both the Graduate Diploma and Masters programs may include:
> The Global Woman: Introduction to Gender and Development
> Gender, Women and World Religions
> Women in Politics
> Gender Analysis

CAREER OUTCOMES
This course provides students with specialist knowledge which can be applied in the gender and development field or associated areas of employment and/or research. Graduates are suitable for careers in environments that specialise in gender or women’s issues. Potential roles include gender mainstreaming specialist, women’s project coordinator (refugee services), fundraising program officer and international development officer. Areas of employment exist in government departments, non-government organisations, international development consultancy organisations and private sector industries with a gender equality or equal opportunity policy and strategy.

FURTHER COURSE INFORMATION >>
flinders.edu.au/courses/postgrad/egmd
flinders.edu.au/courses/postgrad/gmps
CRICOS Code: Graduate Diploma – 028944K. Masters – 008198G

GENDER MAINSTREAMING POLICY AND ANALYSIS
Graduate Certificate in Gender Mainstreaming Policy and Analysis

> Course length: 1 year part-time
> Intake: Semester 1 • Semester 2
> English requirements: IELTS: 6.0 (W6) • PTE: 50 (see page 85)

Entry requirements: Bachelor degree or equivalent qualification from an approved tertiary institution.

Gender analysis is a foundational base for all economic and social development policy and development programs. This course is designed to provide you with specialised knowledge related to the integration of gender considerations into policy making, project design and implementation, monitoring and evaluation. The specialised skills it offers in gender mainstreaming and gender analysis are applicable both in Australia and internationally. Staff teaching the core topics in the Graduate Certificate in Gender Mainstreaming Policy and Analysis were awarded a citation in 2011 for outstanding contributions to student learning by the Australian Learning and Teaching Council.

STUDY PROGRAM
Topics may include the following:
> Gender Analysis
> Gender Mainstreaming
> Applied Development Studies
> Development Problems, Policies and Programs

CAREER OUTCOMES
Graduates are suitable for careers in environments that specialise in gender or women’s issues. Potential roles include quantitative researcher, business operations head, policy public officer and gender mainstreaming specialist. Areas of employment exist in government departments, non-government organisations, international development consultancy organisations and private sector industries with a gender equality or equal opportunity policy and strategy.

FURTHER STUDY
The Graduate Certificate in Gender Mainstreaming Policy and Analysis articulates with the Graduate Diploma in International Development, The Master of Arts (International Development), and the Master of International Development.

FURTHER COURSE INFORMATION >>
flinders.edu.au/courses/postgrad/gcmpp
CRICOS Code: External only
**GERONTOLOGY**
Graduate Certificate in Applied Gerontology; Graduate Diploma in Applied Gerontology; Master of Applied Gerontology

Entry requirements: Graduate Certificate/Diploma – Bachelor degree or equivalent in a health-related field and at least one year relevant ageing work experience. Masters – Bachelor degree or equivalent and at least two years experience in palliative care, aged care or related field.

This articulated, multidisciplinary program was developed to address the professional needs of graduates involved with policy, planning or service delivery for older people. These courses feature seven key perspectives throughout each topic:

> healthy, positive ageing;
> life-course frameworks for understanding ageing;
> multidisciplinary approach;
> multicultural awareness and a global viewpoint;
> lifelong learning and e-learning for improving professional practice;
> research, evaluation and evidence-based planning and service delivery;
> ethical decision making.

Industry experience: Masters students have the opportunity to undertake a practicum.

**STUDY PROGRAM**
Topics in these programs may include:

> Introduction to Social Gerontology
> Introduction to Clinical Gerontology
> Psychological Dimensions of Ageing
> Understanding Literature for Evidence-Based Practice

**CAREER OUTCOMES**
Career opportunities in the field of gerontology are expanding rapidly with global ageing, in a wide variety of areas. Gerontologists work in a range of employment settings including health care settings such as aged care homes, community care and acute hospitals as well as government departments (national, regional and local), universities. Nurses, physicians, allied health and non-clinicians from a range of professions will be able to use gerontological knowledge for policy, planning and practice to meet the needs of older people.

**FURTHER STUDY**
The Graduate Certificate in Applied Gerontology articulates with the Graduate Diploma and the Master of Applied Gerontology.

**FURTHER COURSE INFORMATION >>>

flinders.edu.au/courses/postgrad/ag
CRICOS Code: Graduate Certificate – External only. Graduate Diploma – 072483B. Masters – 072484A

---

**GEOSPATIAL INFORMATION SCIENCE**
Graduate Certificate in Geographical Information Systems; Graduate Diploma in Geographical Information Systems; Master of Geospatial Information Science

**GEOSPATIAL INFORMATION SCIENCE**
Graduate Certificate in Geographical Information Systems; Graduate Diploma in Geographical Information Systems; Master of Geospatial Information Science

Entry requirements: Bachelor degree or equivalent qualification from an approved tertiary institution.

Geospatial information science (GISc) is the study of the theory and practice of spatial analysis through the use of geographical information systems and remote sensing technologies. This articulated program provides students with advanced knowledge in the theory and application of geographical information systems and remote sensing and is intended for students with an undergraduate degree that is not related to studies in Geospatial Information Science. The program provides a theoretical and practical framework for graduates from a range of backgrounds, as well as those in the public sector and non-government organisations wishing to extend their career path by acquiring knowledge and skills in the capture, analysis, and communication of spatially referenced information. Students will develop and implement GISc skills and knowledge applicable to a range of areas, such as environmental management, urban and regional planning, human geography and environmental health, land-use dynamics, natural resources management, ecosystem services, biological sciences, and archaeology.

**STUDY PROGRAM**
Students select from a range of geospatial topics to build a study program that suits their interests and future employment requirements. The program is specifically designed to provide flexibility to students with different levels of GIS and remote sensing experience and skills. Globally relevant concepts taught in the GISc graduate program include spatial data capture and input protocols, database structures, spatial analysis, modelling and communication practices.

**CAREER OUTCOMES**
The use of geospatial information science technologies is rapidly increasing. GISc technologies are now commonly used in industries such as agriculture, forestry, mining, environmental management, biodiversity conservation, archaeology, health and public health, tourism, and many others. Consequently, employers in these areas are now requiring their staff to have more skills in GISc. Potential roles include geographic analyst, GISc data coordinator, GISc technician, geospatial specialist, mapping technology officer, natural resource information officer, remote sensing officer, research officer, spatial ecologist and spatial scientist. Typical employers include government departments, regional development centres, agriculture and horticultural centres, not for profit agencies, and private companies that supply or collect spatial information.

**FURTHER COURSE INFORMATION >>>

flinders.edu.au/courses/postgrad/gis
CRICOS Code: Graduate Certificate – 084259K. Graduate Diploma – 084260F. Masters – 079420E

---

**GLOBAL POINT-OF-CARE TESTING**
Graduate Certificate in Global Point-of-Care Testing

Entry requirements: Bachelor degree or equivalent qualification from an approved tertiary institution.

Point-of-care testing (POCT) is pathology testing performed by a trained operator in an on-site clinical setting at the time of patient consultation on behalf of the treating medical practitioner. This course provides advanced level preparation for health professionals from both Australian and international backgrounds wishing to specialise in point-of-care pathology testing and particular emphasis will be placed on preparing students for working within a multidisciplinary health care team in remote or Indigenous primary care settings in their country of origin. The course is particularly relevant for health professionals with qualifications in the fields of health science, medical science, nursing, medicine, nutrition, paramedic science, Indigenous health or public health, and who would normally have experience, or be currently practising, as a health professional. It will also appeal to new graduates in these fields.

**STUDY PROGRAM**
Examples of topics studied include:

> Advanced Point-of-Care Testing 1 & 2
> Remote & Indigenous Primary Health Care
> Perspectives on Chronic Diseases Management

**CAREER OUTCOMES**
Employment opportunities exist in selected fields where point-of-care testing is widely practiced; these include remote and Indigenous health, chronic disease management, infectious disease and disaster management. Graduates will be qualified to practice as a point-of-care coordinator at a local, national or international level.

**FURTHER COURSE INFORMATION >>>

flinders.edu.au/courses/postgrad/gpct
CRICOS Code: Online only

---

**GROUNDWATER HYDROLOGY**
Graduate Certificate in Science (Groundwater Hydrology); Graduate Diploma in Science (Groundwater Hydrology); Master of Science (Groundwater Hydrology)

Entry requirements: Bachelor degree or equivalent in any relevant discipline of science or engineering from an approved tertiary institution.

Note: Some topics not offered in International mode.

Flinders University is an international leader in groundwater hydrology education and research with one of the largest groups in any Australian university working in the area. Our strong teaching program is complemented by a leading research program for the training of Master of Science and PhD by research projects. Flinders University is a key partner in the National Centre for Groundwater Research and Training, which is located on the Flinders campus. The National Centre provides strong links with industry and access to a large range of expertise not otherwise available, with numerous leading State and Federal agencies such as CSIRO Land and Water, Department of Environment, Water and Natural Resources and other partners. Students have access to National Groundwater Short Courses for professional training which are credited to their degrees, as well as to excellent industry-based research projects.

The Director of the National Centre for Groundwater Research and Training, Professor Craig Simmons, was recently awarded the 2015 South Australian Scientist of the Year award.

Industry experience: Masters students have the opportunity to undertake an industry placement.

**STUDY PROGRAM**
Topics studied may include:

> Public Health Aspects of Water Quality
> Ecohdrology
> Fundamentals of Groundwater

**CAREER OUTCOMES**
Groundwater hydrology is a major growth area for employment worldwide and trained professionals in this area are in demand. Potential positions include senior groundwater environmental scientist/GIS, senior natural systems officer and water engineer. Graduates have found jobs in natural resource and environment agencies of government, environmental consultants in industry sectors such as agriculture, mining, aquacultures and water resource planning and management.

**FURTHER STUDY**
The Graduate Certificate articulates with the Graduate Diploma and the Masters.

**FURTHER COURSE INFORMATION >>>

flinders.edu.au/courses/postgrad/gh
CRICOS Code: Graduate Certificate – 047375C. Graduate Diploma – 047376B. Masters – 047377A
HEALTH AND INTERNATIONAL DEVELOPMENT
Master of Health and International Development

Entry requirements: Applicants must normally hold an approved degree or equivalent qualification from an approved tertiary institution.

The Master of Health and International Development acknowledges the increasing complexity of working in the international development context. In particular it addresses the need for a more thorough understanding of international development by those working in the health sector, and the need for a more informed understanding of the role of health in development for international development managers and practitioners. The course is designed for people working in government, NGOs or private consulting organisations either in Australia or overseas. The content has been developed to meet the needs of both external advisors and local health and/or development personnel.

STUDY PROGRAM
Topics undertaken may include:
> Development Problems, Policies and Programs
> Gender Mainstreaming
> Social Determinants of Health and Wellbeing
> Primary Health Care Practice in Developing Countries
> Public Health Care Practice Development
> Gender Analysis
> Action on Social Determinants of Health

CAREER OUTCOMES
Health and international development is a fast-growing division with long-term trends shaping the sector including an ageing population and advancements in healthcare. Formal training in international development is becoming increasingly important for people wishing to obtain employment in development settings. Graduates may gain employment as international public health officers, international health managers, development field workers, health work trainers, international development project officers and international health research officers. Potential employers include community health providers, government agencies, development agencies, hospitals, non-government organisations and research centres.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/mhid
CIRCOSS Code: 091002J

INFORMATION TECHNOLOGY
Graduate Diploma in Information Technology; Master of Information Technology

Entry requirements: Bachelor degree or equivalent from an approved tertiary institution.

This articulated program was specifically designed to cater for graduates with a previous degree in a non-information technology area who are looking to upgrade and extend their knowledge and skills in an area that has dramatically changed in recent years. Graduates from the award have come from a diverse range of backgrounds and have found employment in a range of areas including, in some cases, areas related to their initial degree. This program capitalises on the re-building demand for professionals as information technology is applied across a continually widening range of applications ranging from intelligent consumer goods such as mobile phones and cars through to electronic medical records.

The course is offered at Flinders’ Tonsley Campus, a state-of-the-art, 18,000 square metre facility. Flinders at Tonsley is a place where students interact with business, and where business interacts with researchers in the areas of engineering, medical devices and nanoscience technologies to make the new products and processes of the 21st century.

Professional accreditation: The Master of Information Technology is accredited by the Australian Computer Society at the Professional level. Courses accredited at this level by the Australian Computer Society are recognised internationally under the Seoul Accord.

STUDY PROGRAM
Topics undertaken may include:
> Fundamentals of Computing
> Software Engineering
> Database and Conceptual Modelling
> Statistical Science

CAREER OUTCOMES
From theory through programming to cutting-edge development of computing solutions, information technology provides students with a solid foundation and the ability to adapt to new and innovative technologies. Potential roles include software developer, software tester, IT project manager, systems analyst, programmer, webmaster, researcher and developer, and networking and communications specialist.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/it
CIRCOSS Code: Graduate Diploma – 038638D. Masters – 038636F

"I chose Flinders University because it has a good reputation and a high standard of educations and courses. My friends in China who were recent graduates of Flinders, strongly recommended that I study here as I wanted to develop my knowledge and skills, rather than just receive a piece of paper."

My course doesn’t just require me to learn from textbooks – it also creates opportunities for me to make connections with real relevant businesses and organisations, as well as many internship opportunities."

Wenxun Zhou (Vincent)
Information Technology student
INNOVATION AND ENTERPRISE
Graduate Certificate in Innovation and Enterprise
Graduate Diploma in Innovation and Enterprise

- Course length: Graduate Certificate: 6 months full-time
  Graduate Diploma: 1 year full-time
- Intake: Semester 1 + Semester 2
- Opportunity for industry experience

Entry requirements: Entry into the Graduate Certificate requires a bachelor degree or 5 years work experience in a relevant area (e.g. entrepreneurship, innovation, enterprise). Entry into the Graduate Diploma requires a bachelor degree in any discipline, or completion of the Graduate Certificate in Innovation and Enterprise (or equivalent).

Our programs in Innovation and Enterprise are designed to utilise creativity and innovation in strategy formation. Students will immerse themselves in creative problem solving, applying innovative principles, understanding disruptive markets, identifying and maximising opportunities, as well as exploring novel new business models and how to innovate and evaluate viability. Flinders Business School’s teaching philosophy and small class sizes ensure that you can really engage with your teacher, while getting to know your fellow students. You will also have access to workshops and events with experienced entrepreneurs and other relevant industry practitioners.

Industry experience: Students may have the opportunity to undertake an industry placement and/or project.

STUDY PROGRAM
Some of the topics studied as part of these programs may include:
> Innovative and Creative Thinking: Recognising Opportunities
> Social Entrepreneurship: Doing Good While Doing Well
> Sustainable Development
> Global Inequality
> Creative Problem Solving
> Social Movements

CAREER OUTCOMES
Graduates are equipped with practical tools to successfully start and bring to maturity new ventures, or alternatively, grow new revenue streams for employers. They will be better prepared to engage in the innovation and development of the future. Graduates can work as a small and medium business owner across all industries. Graduates who take on roles other than of owner, general manager, or small business manager, will have the opportunity to put theory into practice with local and international internships and placements.

STUDY PROGRAM
Areas of study may include:
> Development Problems, Policies and Programs
> Sustainable Development
> Gender Analysis

CAREER OUTCOMES
International development offers a growing range of employment opportunities. Potential roles include international development officer, regional development manager, strategic analyst, project officer, international policy advisor and international business development manager. Employment opportunities include non-government organisations, consultancies, governments, and the development consultancy industry.

FURTHER STUDY
The International Development programs articulate with sequentially developed topics that allow progression through the awards.

INTERNATIONAL DEVELOPMENT
Graduate Certificate in International Development; Graduate Diploma in International Development; Master of Arts (International Development); Master of International Development

- Course length: Graduate Certificate: 6 months full-time
  Graduate Diploma: 1 year full-time
  Master of Arts: 1.5 years full-time
- Intake: Semester 1 + Semester 2
- Opportunity for industry experience

Entry requirements: Graduate Certificate and Graduate Diploma: Bachelor degree or equivalent from an approved tertiary institution. Masters: Refer to flinders.edu.au/courses/postgrad/id

The International Development programs, offered by the School of History and International Relations, are interdisciplinary in nature and explore the social, political and cultural forces transforming developing countries within a global context. Staff across the social sciences contribute elective topics covering a wide range of related disciplines including area studies, demography, environment, geography, international relations, public policy, political studies, and public health. International development focuses on developing countries of the Global South – their culture, economy, society, history and politics. It analyses how societies are transformed by historical and contemporary processes of social change and examines efforts by governments, development agencies and social movements to address vital common problems.

Industry experience: You will have the opportunity to put theory into practice with local and international internships and placements available.

STUDY PROGRAM
Areas of study may include:
> New Security Agenda
> Global Inequality
> Debating International Relations
> International Human Rights: Theory and Practice

CAREER OUTCOMES
Graduates are suitable for careers in foreign affairs, defence, international trade and related areas. Potential roles include international development officer, regional development manager, strategic analyst, project officer, international policy advisor and international business development manager. Typical employers of international relations graduates include government departments, councils, charities, accountancy and banking organisations, law firms, retail and media companies.

FURTHER STUDY
The International Relations programs articulate, with sequentially developed topics that allow progression through the three awards.

INTERNATIONAL RELATIONS
Graduate Certificate in International Relations; Graduate Diploma in International Relations; Master of Arts (International Relations)

- Course length: Graduate Certificate: 6 months full-time
  Graduate Diploma: 1 year full-time
  Masters: 2 years full-time
- Intake: Semester 1 + Semester 2
- Opportunity for industry experience

Entry requirements: Bachelor degree or equivalent from an approved tertiary institution.

This program explores contemporary theory and research in international relations and offers an opportunity to specialise in international theory and the international relations of the Asia-Pacific region. It provides a specialised postgraduate education for students who may seek to pursue later doctoral studies or professional employment in foreign affairs, defence, international trade, journalism or related areas. The program is taught by staff from Flinders University’s School of History & International Relations, one of Australia’s leading centres of teaching and research in international relations.

STUDY PROGRAM
Topics studied may include:
> New Security Agenda
> Global Inequality
> Debating International Relations
> International Human Rights: Theory and Practice

CAREER OUTCOMES
Gerads are suitable for careers in foreign affairs, defence, international trade and related areas. Potential roles include international development officer, regional development manager, strategic analyst, project officer, international policy advisor and international business development manager. Typical employers of international relations graduates include government departments, councils, charities, accountancy and banking organisations, law firms, retail and media companies.

FURTHER STUDY
The International Relations programs articulate, with sequentially developed topics that allow progression through the three awards.

JURIS DOCTOR
Juris Doctor

- Course length: 3 years full-time
- Intake: Semester 1 + Semester 2 + Semester 3
- Opportunity for industry experience

Entry requirements: Applicants must normally hold either an approved Bachelor degree or equivalent qualification in a discipline other than Law from an approved tertiary institution; or an approved Bachelor degree or equivalent qualification in Law that does not give entitlement to admission to practice law in Australia.

The Juris Doctor (JD) seeks to provide the academic knowledge and skills needed to embark upon a career as a practising lawyer, but was also created in the knowledge that not all graduates want, or are able, to work as barristers or solicitors.

It is taught in collaboration with the legal profession and provides opportunities for learning in an authentic context, with real client work experience a requirement of the course. The JD articulates with the Graduate Diploma in Legal Practice, allowing graduates to satisfy the academic and practical requirements for admission as a legal practitioner. If you complete the Flinders JD you will normally receive credit for two out of the eight topics in the Graduate Diploma.

This course is approved by the Legal Practitioners Education and Admission Council (LPEAC).

STUDY PROGRAM
Topics studies may include:
> The Australian Legal System
> Professional Identity
> Clinical Legal Education
> Capstone Explorations of the Professional Environment
> Legal Analysis and Problem Solving
> Dispute Resolution
> Contract
> Torts
> Property, Equity and Trusts
> Constitutional Law
> Administrative Law
> Criminal Law
> Corporate Law
> Real Property Law
> Advanced Dispute Resolution
> Evidence

CAREER OUTCOMES
The Juris Doctor in combination with the Graduate Diploma in Legal Practice will satisfy the academic and practical requirements for admission to the legal profession under the rules of the Legal Practitioners’ Education and Admission Council 2004. Graduates of the Juris Doctor and Graduate Diploma in Legal Practice will qualify to practise as a barrister and solicitor and work in law firms, government, private-sector organisations, policy development, administration, social justice and human rights, in Australia and internationally.

FURTHER COURSE INFORMATION
> flinders.edu.au/courses/postgrad/id

CRICOS Code: 045233M, Graduate Diploma – 045234K, Masters – 020923B

58

59
**LANGUAGE STUDIES**
Master of Language Studies

Entry requirements: Bachelor degree or equivalent that includes a major completed with a GPA of 5.0 or higher in one or more of the following languages: French, Modern Greek, Spanish, Italian or Indonesian.

This course is designed to provide an advanced level of understanding of one of the following areas of specialisation: Cultural Studies, (relative to French, Italian, Modern Greek, or Spanish), Applied Linguistics or Teaching English as a Second Language (TESOL). The course will train students to form broad conceptual understandings while gaining depth of knowledge of a particular area of the above specialisations, through coursework and through a dissertation-style research project.

**STUDY PROGRAM**
Topics undertaken in the Master of Language Studies program may be chosen according to the following program of study:
- Topics offered in Cultural Studies, Applied Linguistics, Teaching English as a Second Language and Study Abroad
- Research Project

**CAREER OUTCOMES**
The Master of Language Studies provides advanced practical language training and vocational knowledge and abilities in areas relevant to the language profession. With the internationalisation of the job market, graduates with a qualification in a foreign language will have greater employment opportunities across the globe. Potential roles include language teacher, communications specialist, immigration officer, international student advisor, interpreter, linguist, multicultural service officer, translator and travel consultant. Potential areas of employment include tourism agencies, foreign language teaching, international trade, finance and commerce, diplomatic and defence agencies, translating services, and international development.

**FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/MLS
CRICOS Code: 06498B9

---

**LANGUAGE TEACHING**
Graduate Certificate in Language Teaching, Graduate Diploma in Language Teaching

Entry requirements: Bachelor degree or equivalent. You must also be eligible for registration as a teacher in Australia and have had at least one year teaching experience in a school or other approved institution.

Facilities provide an opportunity to learn on-line and readily engage with the person leading the learning while also interacting with fellow students. Students will have access to interactive activities and online group discussions which will expand their international law and intentional relations skills into areas such as energy and environmental security, human security, international relations in the Asia/Pacific, causes and conduct of conflict and post-conflict mechanisms.

**STUDY PROGRAM**
The initial first-semester topic for the Graduate Certificate and Graduate Diploma presumes no previous knowledge of the language. Both courses include the study of the language through the four skills of listening, speaking, reading and writing; the study of the society and culture of the country or countries where the language is spoken; as well as an introduction to second language acquisition through the following specifically-designed topic:
- > Introduction to Second Language Acquisition

The methodology module for the Graduate Diploma comprises a further topic chosen from either:
- > Second Language Teaching Methodology
- > Introduction to Classroom-based Research

**CAREER OUTCOMES**
With the internationalisation of the job market, graduates with a qualification in language teaching will have greater employment opportunities across the globe. Graduates of this articulated program are suitable for teaching English in Australia at private language colleges, university language centres and overseas at schools, universities and private language colleges.

**FURTHER STUDY**
These courses articulate with the Master of Language Studies.

**FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/lT
CRICOS Code: External only

---

**LANGUAGES (INTERNATIONAL LAW AND INTERNATIONAL RELATIONS)**
Master of Law (International Law and International Relations)

Entry requirements: 1.5 Years (54 units) - Applicants must normally hold an approved bachelor degree or equivalent qualification from an approved tertiary institution in Law or in another discipline related to the field of study. 2 Years (72 units) - Applicants must normally hold an approved bachelor degree or equivalent qualifications from an approved tertiary institution.

The Master of Laws (International Law and International Relations) is a coursework and research program delivered fully online and offered by the Flinders Law School in conjunction with the School of History and International Relations. It is designed to provide students with the opportunity to learn online and readily engage with the person leading the learning while also interacting with fellow students. Students will have access to interactive activities and online group discussions which will expand their international law and intentional relations skills into areas such as energy and environmental security, human security, international relations in the Asia/Pacific, causes and conduct of conflict and post-conflict mechanisms.

**STUDY PROGRAM**
Topics studied may include:
- > Approaches to International Relations
- > Principles of Public International Law
- > Research Paper International Law/International Relations

**CAREER OUTCOMES**
This course will equip you with the academic qualifications necessary to a seek employment in government service in areas of foreign affairs, international diplomacy, law, defence, foreign aid and trade. It may also qualify you for positions with international bodies and non-government organisations involved with the implementation of international law (including international criminal law), human rights advocacy, international relations including humanitarian assistance, aid distribution and other associated work auxiliary to government.

**FURTHER STUDY**
Students who complete the 18-unit research project in the Masters degree may be eligible to apply for entry into a PhD.

**FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/lawir
CRICOS Code: Online only

---

**LOSS, GRIEF AND TRAUMA COUNSELLING**
Graduate Certificate in Loss, Grief and Trauma Counselling

Entry requirements: Bachelor degree or equivalent from an approved tertiary institution.

This course offers a great deal of choice and every attempt is made to meet each candidate’s interests and learning needs. This is a specialised course for social workers, nurses, teachers, counsellors and other professionals who wish to gain the specific skills and knowledge required to assist people suffering loss, grief or trauma.

**STUDY PROGRAM**
Topics you may study include:
- > Bereavement and Loss
- > Interventions in Situations of Trauma
- > Professional Practice Project

**CAREER OUTCOMES**
Potential future roles include community services project officer, case manager, school counsellor, mental health nurse, social research officer and youth pathways officer. Graduates of this course are employed in governmental departments, hospitals, health and community centres, correctional services, schools, and welfare agencies.

**FURTHER STUDY**
Students accepted into Master of Social Work normally receive 4.5 units (one topic) of credit if successfully completed within the Graduate Certificate.

**FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/gclgtc
CRICOS Code: 036367E

---
The Graduate Program in Maritime Archaeology is the largest, most successful and most active program of its kind in Australia, and is rated as one of the top six programs of its kind in the world. The program is designed to meet the needs of students who have a degree in archaeology, maritime archaeology or anthropology who wish to specialise in maritime archaeology, and also to provide a different academic background (such as history) and want to move to a different career path.

STUDY PROGRAM

Some of the topics offered may include:>

> Maritime Archaeology in Australia
> The Archaeology of Seafaring
> Maritime Archaeology Field School

CAREER OUTCOMES

Career opportunities in underwater archaeology are steadily growing. Potential roles include a conservator officer, museum/gallery curator, museum education officer, higher education lecturer, tourism officer, archivist and cartographer. Potential employers include independent archaeological consultants, heritage agencies, museums, academic institutions, the public service, wildlife services and sanctuaries.

FURTHER STUDY

The Graduate Certificate in Maritime Archaeology articulates with the Graduate Diploma in Maritime Archaeology and the Master of Maritime Archaeology.

FURTHER INFORMATION >>>

flinders.edu.au/courses/postgrad/mmath

CRICOS Code: Graduate Certificate – External only.
Graduate Diploma – 046437B. Master – 070595F

MATHMATICS

Master of Science (Mathematics)

> Course length: 2 years full-time
> Intake: Semester 1 and Semester 2
> English requirements: IELTS: 6.5 (or equivalent)

Entry requirements: Applicants must normally hold an approved bachelor’s degree in mathematics or statistics or a closely related discipline from an approved institution. Applicants with an approved degree that contains substantial mathematics or statistics (up to second year level) are also eligible to apply. The Faculty Board may, under certain circumstances and subject to specific conditions, admit others who can show evidence of fitness for candidature. The Master of Science is not available to students who hold an Honours degree in the same discipline.

Medicine

Doctor of Medicine

Entry requirements: For all prerequisites and entry requirements please refer to: flinders.edu.au/MD/int

Medicine is one of the most rapidly changing fields of human endeavour. This is both a challenge and a source of satisfaction for medical graduates, who must commit to lifelong learning to stay abreast of new developments in their profession. Research is extending the boundaries of our understanding of health and disease, creating new possibilities for prevention, treatment and care. Community expectations of doctors and the healthcare system are changing, and new ethical debates and social challenges constantly emerge. The Flinders medical program aims to develop those elements of knowledge, understanding and skill central to varied areas of medical practice, producing graduates well prepared to act as hospital interns and with the potential to follow a full range of medical specialties in subsequent training. Flinders has a strong profile in medicine both nationally and internationally and is well equipped to meet the needs of students who wish to specialise in varying fields of medicine.

The program focuses on student-centred learning with longitudinal development of the knowledge, skills and personal attributes required of a doctor. Themes covered in first year include the knowledge of health and illness, the doctor and patient (including clinical and communication skills), ethics, law, the humanity of medicine, and developing expertise in research.

CAREER OUTCOMES

Upon graduation, you must complete a year as a hospital intern to qualify for medical registration with the Medical Board of Australia. After internship and a possible further year in a training position, you can then apply to undertake specialist training with a medical college. In addition to clinical practice in a wide range of medical specialties, medical graduates may work in research, public health or community care around the world, or in health administration. This course has a specific application deadline. Please contact the International Centre at internationalapply@flinders.edu.au for more information.

FURTHER INFORMATION >>>
flinders.edu.au/medicine/courses/medical-course/medical-course-home.cfm

CRICOS code: 077675J

CAREER OUTCOMES

Graduates will be able to work in leadership roles and contribute to the development of the profession by advancing midwifery knowledge and practice research, promoting excellence in midwifery practice, developing inter-disciplinary and inter-organisational partnerships and promoting midwifery care through a primary health care approach. Graduates have existing midwifery career opportunities in community and hospital clinical practice, research, education or management roles. Potential roles include antenatal education facilitator/midwife, clinical midwife, clinical midwife consultant, community midwife, and research project officer. Please note, the postgraduate Midwifery courses do not lead to registration as a Registered Midwife.

FURTHER INFORMATION >>>
flinders.edu.au/courses/postgrad/mmid

CRICOS Code: Graduate Diploma – 071426G. Master – 028951M

MEDICINE

Graduate Diploma in Midwifery, Master of Midwifery (Coursework), Master of Midwifery (Coursework and Research)

CAREER OUTCOMES

Graduates with a Bachelor degree or equivalent, be a registered midwife, and hold a current practising certificate in your country of residence.

The course aims to provide the opportunity for registered midwives to deepen their knowledge and skills in midwifery and prepare them for an expanded practice role in an innovative program of study. This course will not lead to registration as a midwife.
NANOTECHNOLOGY
Graduate Diploma in Nanotechnology, Master of Nanotechnology

Entry requirements:
- Bachelor degree or equivalent in any relevant discipline of science or engineering from an approved institution. Examples of relevant disciplines include but are not limited to chemistry, physics, materials engineering, chemical engineering or biotechnology. The Faculty Board may, under certain circumstances and subject to specific conditions, admit others who can show evidence of fitness for candidature.

The project will also equip you with expert skills in advanced study of selected areas. Project work is a key part and provides an extended research project in which the knowledge and skills in core areas and subsequently extends this via advanced research and technological development. The primary aim of this suite of degrees is to facilitate skills transfer from another relevant area of engineering, science or technology to the study of nanotechnology.

STUDY PROGRAM
The Graduate Diploma in Nanotechnology provides a comprehensive coverage of the fundamental knowledge and skills in the core areas of nanotechnology.

The Master of Nanotechnology covers fundamental knowledge and skills in core areas and subsequently extends this via a more applied study of selected areas. Project work is a key part of the Masters degree, which is designed to develop research and problem solving skills. At the core of the second year is an extended research project in which the knowledge and skills gained in the first year are applied to a specific problem.

The project will also equip you with export skills in advanced experimental tools in the area of nanotechnology which will further enhance your employment prospects in the industry.

CAREER OUTCOMES
Whatever the environment, commercial or research, employment opportunities will be at the cutting edge of technology. Potential occupations include nanofabrication technician, nanomaterial scientist, nanomaterials business manager, nanosystems scientist, production supervisor, research officer and technical officer. Graduates of this specialisation may find research-based careers.

FURTHER STUDY
The Graduate Diploma in Nanotechnology articulates with the Master of Nanotechnology.

FURTHER COURSE INFORMATION
flinders.edu.au/courses/postgrad/ntc
CIRICOS Code: Graduate Diploma – 057869J.
Master – 057870E

NURSING (ACUTE CARE)
Graduate Diploma in Nursing (Acute Care), Master of Nursing (Acute Care)

Entry requirements:
- You must hold a nursing degree or equivalent and must be a registered nurse. In addition, applicants must provide a supporting statement nominating their area of clinical preference for university sourced observational professional experience placement.

The Acute Care Nursing specialisation is specifically designed for international post graduate students. It aims to facilitate the development of specialist knowledge and skills in acute care, complex outcomes, and the potential for deteriorating patient in a range of acute health care settings.

You can select topics from a range of specialisations including cardiac care, critical care, high dependency and emergency nursing, paediatric and mental health nursing. Students have the opportunity to undertake an observational professional experience placement (PEP) in a South Australian acute setting.

This will enable students to contextualise care in Australia and exchange information about nursing practices in their country of origin.

STUDY PROGRAM
Topics studied may include:
- Prevention of Cardiovascular Disease
- Managing High Acute Medical Care
- Acute Care Obsessional PEP
- Contemporary Issues in Paediatric Nursing
- Critical Care Nursing Theory
- Acute Mental Health Nursing Theory
- Principles of Emergency Nursing

CAREER OUTCOMES
Graduates are suitable for careers in a wide range of nursing-related fields. Our courses will give registered nurses the opportunity to provide specialised care to individuals across the lifespan in a range of acute care settings. They will be able to make an impact in their field by taking on leadership roles in a variety of clinical nursing settings. Potential occupations include case coordinator, clinical nurse specialist, injury management officer, mental health nurse, research assistant, registered nurse and rehabilitation consultant.

FURTHER COURSE INFORMATION
flinders.edu.au/courses/postgrad/ntc
CIRICOS Code: Graduate Diploma – 088942D. Master – 088943C.

NURSING (GLOBAL HEALTH CARE)
Graduate Diploma in Nursing (Global Health Care), Master of Nursing (Global Health Care)

Entry requirements:
- Graduate Diploma and Masters: you must hold an approved degree or equivalent qualifications, and be a registered nurse. However, the Faculty Board may, under certain circumstances and subject to specific conditions, admit others who can show evidence of fitness for candidature.

The Global Health Care specialisation provides the opportunity for health professionals anywhere in the world to develop and apply advanced knowledge, skills and attributes related to nursing and midwifery in a global context.

In an increasingly connected world with growing demand for health services in developing countries, the time is right for you to step up and into the global health arena.

Take the next step in your nursing career to develop the skills and knowledge to transform your nursing work for an international workforce. In a multicultural Australia, everything you learn will also help you become a contemporary nursing leader.

STUDY PROGRAM
Three study pathways are available: Leading Quality and Safety, International Health Care and Learning and Teaching.

CAREER OUTCOMES
Graduates are suitable for careers in a wide range of international health care settings including developing policy for practice, the teaching and learning environment, hospital administration and quality process in Australia and overseas and international strategies and programmes in health care.

FURTHER COURSE INFORMATION
flinders.edu.au/courses/postgrad/ngac
CIRICOS Code: Graduate Diploma – 088950D. Master – 088951C

NURSING (PRIMARY HEALTH CARE)
Graduate Diploma in Nursing (Primary Health Care), Master of Nursing (Primary Health Care)

Entry requirements:
- You must normally hold an approved degree or equivalent qualification and must be a registered nurse in a country that provides a supporting statement nominating your area of clinical preference for university sourced observational professional experience placement. However, the Board may, under certain circumstances and subject to specific conditions, admit others who can show evidence of fitness for candidature.

The Primary Health Care (Nursing) specialisation is specifically designed for international postgraduate students. It aims to facilitate the development of specialised knowledge of the constructs and contexts of working with individuals, groups, families and communities within a broad primary health care framework.

You can select topics from a range of specialisations including aged care, child and family health nursing, diabetes management and education, general practice and community nursing. Uniquely, students also have the opportunity to undertake an observational professional experience placement (PEP) in a South Australian primary health care setting.

This will enable you to contextualise care in Australia and exchange information about nursing practices in their country of origin.

STUDY PROGRAM
Topics studied in the pathways may include:
- Global Perspectives on Policy and Political Contexts of Healthcare
- Safety and Quality: A Global Health Approach
- Measuring Health Service Outcomes
- Health and Sustainable Development
- International Strategies and Programs in Health Care
- Enhancing the Learner Experience
- Planning for Learning: Curriculum Development

CAREER OUTCOMES
Graduates are suitable for careers in a wide range of nursing-related fields. Our courses will give registered nurses the opportunity to provide specialised care to individuals across the lifespan in a range of primary care settings. They will be able to take on leadership and specialised care roles in a variety of clinical nursing settings.

CAREER OUTCOMES
Graduates are suitable for careers in a wide range of nursing-related fields. Our courses will give registered nurses the opportunity to provide specialised care to individuals across the lifespan in a range of primary care settings. They will be able to take on leadership and specialised care roles in a variety of clinical nursing settings.

Further information can be found at: flinders.edu.au/courses/postgrad/npht
CIRICOS Code: Graduate Diploma – 088849D, Master – 0888495

FURTHER COURSE INFORMATION
flinders.edu.au/courses/postgrad/npht
CIRICOS Code: Graduate Diploma – 088849D, Master – 0888495
NURSING (COURSEWORK AND RESEARCH)  
Master of Nursing (Coursework and Research)

Course length: 2 years full-time
Intake: Semester 1
Opportunity for industry experience
Professional accreditation

Entry requirements: Applicants must normally hold an approved degree or equivalent qualification and must be registered nurses. Applicants for this pathway will be required to provide a brief statement (research proposal) regarding the area of research they would like to undertake. Research proposals are subject to Course Coordinator approval and the School’s ability to provide suitable research supervision to students depending on their proposed research topic. Under certain circumstances and subject to specific conditions, the Board may admit others who can show evidence of fitness for candidature.

This course aims to provide advanced studies in nursing practice and research to prepare nurses to contribute to the present and future development of health care services and the nursing profession. In addition to developing specialist nursing skills and competencies, you will have the opportunity to conduct research in an area of interest with the support of individualised supervision from the School of Nursing & Midwifery.

Throughout the program, you will be introduced to the drivers for research within society and the broader community; learn to identify and apply appropriate research paradigms and methods, and develop sound project management skills.

You will become competent at reviewing, critiquing and synthesising literature to support their research and will develop skills for completion and submission of research grant proposals for ethical approval and funding applications.

Successful completion of the program through submission of an (18 unit) minor thesis prepares students for higher degree research studies (PhD) and/or research in the clinical setting.

STUDY PROGRAM
Topics studied may include:
> Introduction to Research
> Developing a Literature Review
> Approaches to Research Designs
> Writing Research Proposals for Ethical and Funding Requirements

CAREER OUTCOMES
The Master of Nursing (Coursework and Research) will open a new door on your health career. Potential graduate outcomes include working as a clinical nursing specialist, healthcare researcher, educator, manager or policy leader. Offered by the School of Nursing & Midwifery, this program enables you to gain specialist skills whilst undertaking a research project. It also has the potential to lead to a PhD.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/ngr
CRICOS Code: 088952B

NUTRITION AND DIETETICS  
Master of Nutrition and Dietetics

Course length: 2 years full-time
Intake: Semester 1
Opportunity for industry experience
Professional accreditation

Entry requirements: Approved bachelor degree or equivalent with a credit average, which includes, 40% of undergraduate topics in human nutrition and food science, at second year level, at least 25% of a full-time load of biochemistry topics and 15% of a full-time load of physiology topics.

Note: As per Australian Government regulations, courses that have a placement involving contact with children, young people and/or vulnerable adults, will require students to undergo an Offender History Check prior to placement.

The Master of Nutrition and Dietetics offers advanced studies in nutrition and dietetics, the palato-physiology of nutrition related illnesses, health promotion, communication skills and clinical, community and public health nutrition skills. The aim is to train nutritionists and dietitians who are able to integrate and apply their knowledge, skills and attributes to the promotion of health and the prevention and treatment of illness by optimising the nutrition of communities and individuals.

Industry experience: Students will undertake a clinical placement.
Professional accreditation: The course equips graduates to meet the entry level competency standards specified by the Australian professional body, the Dietitians Association of Australia (DAA).

STUDY PROGRAM
Topics you may study include:
> The Nutrition Care Process
> Food Service and Professional Practice
> Research Methods and Critical Thinking in Human Nutrition
> Communication and Nutrition Counselling
> Clinical Nutrition and Dietetics

CAREER OUTCOMES
Potential roles include clinical dietitian, community health worker, nutritionist, health promotion officer and research project officer. Employment opportunities are plentiful across a variety of settings including hospitals, community health centres, private practice and consultancy, food industries, and research institutions.

This course has a specific application deadline. Please contact the International Centre at internationalapply@flinders.edu.au for more information.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/mnd
CRICOS Code: 090865M

OCCUPATIONAL THERAPY  
Master of Occupational Therapy

Course length: 2 years full-time
Intake: Semester 1
Opportunity for industry experience
Professional accreditation

Entry requirements: Applicants must normally hold an approved degree with a GPA of no less than 5.0, or an equivalent qualification; and have either completed the Bachelor of Health Sciences (Principles of Occupational Therapy) at Flinders University OR demonstrated that they have completed the following pre-requisite topics: the equivalent of 9 units of study focussed on an understanding of body structures and function such as human biology, physiology and anatomy including detailed musculoskeletal anatomy with an emphasis on the upper limb; the equivalent of 4.5 units of study focussed on an understanding of the human and social environment and social perspectives in health such as psychology and sociology; the equivalent of 4.5 units of study in research methodologies; and the equivalent of 4.5 units of study in communication skills.

This course aims to prepare students for professional practice as occupational therapists (OT). Graduates will be able to practice across a range of settings, including rural and remote areas. Emphasis will be placed on preparing a contemporary health professional able to be client-centred and to work effectively within an interdisciplinary team. Close partnerships with clinical agencies ensure supported placement experiences.

Industry experience: Students undertake 1050 hours of clinical placement in accordance with the accreditation standards of the Occupational Therapy Council of Australia.
Professional accreditation: This course has been developed to meet the Occupational Therapy Council’s Accreditation Standards (2012) and also the requirements of the World Federation of Occupational Therapy in regard to occupational therapy programs. The Master of Occupational Therapy has fulfilled the requirements for entry level education of occupational therapists and has been accredited with the status of Accredited Occupational Therapy Course by Occupational Therapy Australia and the World Federation of Occupational Therapists.

STUDY PROGRAM
Topics you may study include:
> The Occupational Therapy Process
> Occupational Science
> Occupational Therapy Evaluation and Practice 1
> Information and Technology in Occupational Therapy

CAREER OUTCOMES
Graduates can go on to further their careers in roles such as knowledge managers, human resource managers, school principals, university administrators, and line managers with a strong focus in human resource and organisational development.

FURTHER STUDY
The Graduate Certificate in Occupational Learning is designed for professionals who aim to build the human capital of their organisations to achieve its mission and strategic goals. It is of direct relevance to those individuals in leadership positions and human resources/organisational development roles. The Graduate Certificate in Organisational Learning seeks to provide students with the ability to analyse the existing learning and knowledge context for their own organisation; formulate strategies to develop and improve the organisational learning in their workplace; and harness organisational and individual knowledge to achieve strategic goals.

Industry experience: Students may have the opportunity to undertake an internship.

STUDY PROGRAM
Topics you may study include:
> Knowledge Management for Organisational Learning
> Evaluation Methods
> Action Learning Project/Internship
> Leaders and Leadership
> Managing Innovation in Organisations
> Critical Systems: Thinking and Practice

CAREER OUTCOMES
Graduates in this field focus on careers as knowledge managers, human resource managers, school principals, university administrators, and line managers with a strong focus in human resource and organisational development.

FURTHER COURSE INFORMATION >>>
flinders.edu.au/courses/postgrad/gcol
CRICOS Code: 055238A
PALLIATIVE CARE
Graduate Certificate in Palliative Care: Graduate Diploma in Palliative Care; Master of Palliative Care

<table>
<thead>
<tr>
<th>Course length:</th>
<th>Graduate Certificate: 6 months full-time</th>
<th>Graduate Diploma: 1 year full-time</th>
<th>Masters: 1.5 years full-time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intake:</td>
<td>Semester 1 + Semester 2</td>
<td>Semester 1 + Semester 2</td>
<td>Semester 1 + Semester 2</td>
</tr>
</tbody>
</table>

Entry requirements: Must hold an approved Bachelor degree or equivalent from an approved tertiary institution. Graduate Certificate: must meet the above requirements and have no less than one year clinical experience in health care. Graduate Diploma and Masters: must meet the above requirements and have no less than two years’ clinical experience in health care.

The Palliative Care program provides an opportunity for professionals from any discipline to deepen their knowledge base in palliative care within a global context. The programs aim to develop independent critical thinkers who will be able to contribute to the appraisal, assessment and problem-solving required of a multidisciplinary/multi-professional team.

STUDY PROGRAM
Topics studied may include:
> Communication at the End of Life
> Oncology for Palliative Care
> Issues in the Care of the Spirit in Palliative Care
> Palliative Care in Aged Care Settings
> Palliative Clinical Management
> Suffering, Futility and Ethics in Palliative Care
> Understanding Cancer
> Design and Ethics in Research with Vulnerable Populations

Master of Palliative Care students:
> Independent Inquiry for Evidence-Based Practice

CAREER OUTCOMES
Palliative care has an increasingly significant focus on development at local and national levels within multiple healthcare settings including hospitals, nursing homes and community care. Organisations require practitioners with the specialist skills and attitudes provided by this course, whether experienced practitioners or graduates with basic palliative care skills. Graduates find careers in areas ranging from rural and remote acute/community aged care settings to palliative care units and hospice care.

FURTHER STUDY
The sequentially developed topics allow progression through these awards.

FURTHER COURSE INFORMATION >> flinders.edu.au/courses/postgrad/ppc

CIRCOS Code: Graduate Diploma – 072449A. Graduate Diploma in Palliative Care – 051998D. Master of Palliative Care – 054776J

PALLIATIVE CARE IN AGED CARE
Graduate Diploma in Palliative Care in Aged Care; Master of Palliative Care in Aged Care

<table>
<thead>
<tr>
<th>Course length:</th>
<th>Graduate Diploma: 1 year full-time</th>
<th>Masters: 1.5 years full-time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intake:</td>
<td>Semester 1 &lt; Semester 2</td>
<td>Semester 1 &lt; Semester 2</td>
</tr>
</tbody>
</table>

Entry requirements: Must hold an approved Bachelor degree or equivalent from an approved tertiary institution. Graduate Diploma: must meet the above requirements and have no less than two years’ clinical experience in health care. Graduate Diploma and Masters: must meet the above requirements and have no less than two years clinical experience in health care.

The Palliative Care in Aged Care programs are designed to provide education for practitioners with backgrounds in gerontology, aged care or palliative care who are involved in policy, planning, or the delivery of palliative care services to older people in a range of aged care settings. The programs introduce the basic skills and principles of palliative care within a broader study of ageing, which provides an examination of different views of ageing and the concepts of ageing and dying in a global context.

STUDY PROGRAM
Topics studied may include:
> Communication at the End of Life
> Oncology for Palliative Care
> Issues in the Care of the Spirit in Palliative Care
> Palliative Care in Aged Care Settings
> Palliative Clinical Management
> Suffering, Futility and Ethics in Palliative Care
> Understanding Cancer
> Design and Ethics in Research with Vulnerable Populations

Master of Palliative Care in Aged Care students:
> Independent Inquiry for Evidence-Based Practice

CAREER OUTCOMES
Palliative care in aged care has an increasingly significant focus on development at local and national levels within multiple healthcare settings including hospitals, nursing homes and community care. Organisations require practitioners with the specialist skills and attitudes provided by this course, whether experienced practitioners or graduates with basic palliative care skills. Graduates find careers in areas ranging from rural and remote acute/community aged care settings to palliative care units and hospice care.

FURTHER STUDY
The sequentially developed topics allow progression through these awards.

FURTHER COURSE INFORMATION >> flinders.edu.au/courses/postgrad/ppcac

CIRCOS Code: Graduate Diploma – 072448M. Masters – 072448K

PARAMEDIC SCIENCE
Master of Paramedic Science

<table>
<thead>
<tr>
<th>Course length:</th>
<th>2 years full-time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intake:</td>
<td>Semester 1 + Semester 2</td>
</tr>
</tbody>
</table>

Entry requirements: Applicants must hold either a Bachelor of Paramedic Science or an equivalent degree, or possess a formal vocational ambulance qualification which permits authority to practice at a paramedical level. A minimum of two years industry experience as a practicing paramedic is required. The Faculty Board may, under certain circumstances and subject to specific conditions, admit others who can show evidence of fitness of candidature.

The Master of Paramedic Science will build upon the Intensive Care Paramedic knowledge and add additional knowledge to support practice at extended care level or alternatively (depending on the stream) industrial paramedic.

STUDY PROGRAM
First year topics include:
> Principles of Industrial Health Practice
> Principles of Extended Care Paramedic Practice
> Advanced Health Care Assessment and Diagnosis
> Advanced Primary Health Care for Paramedics 1
> Advanced Primary Health Care for Paramedics 2
> Research Project
> Research Thesis

CAREER OUTCOMES
The intensive care course equips paramedics with the knowledge required to support intensive care practice. This Masters course builds upon the intensive care course equipping paramedics with knowledge to support practice as an extended care paramedic, an industrial paramedic or for a research career.

FURTHER COURSE INFORMATION >> flinders.edu.au/courses/postgrad/paramedst

CIRCOS Code: 088779K

PHYSICS
Master of Science (Physics)

<table>
<thead>
<tr>
<th>Course length:</th>
<th>2 years full-time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intake:</td>
<td>Semester 1 + Semester 2</td>
</tr>
</tbody>
</table>

Entry requirements: Applicants must normally hold an approved Bachelor’s degree or equivalent with a major in Physics or a closely related discipline from an approved institution. A knowledge of at least second year physics and mathematics is assumed. The Faculty Board may, under certain circumstances and subject to specific conditions, admit others who can show evidence of fitness of candidature. The Masters of Science is not available to students who hold an Honours degree in the same discipline.

The Master of Science (Physics) is designed for students with a physics-rich background. The course builds on a student’s existing physics, research and professional skills. The Masters award provides graduates with not only the practical and theoretical aspects of physics, but also an understanding of professional and ethical responsibilities and an awareness of social, economic, cultural and environmental aspects of physics in a global community. Projects and coursework have been designed to address topical concerns in industry and society, preparing graduates for employment in a physics-related field or further enrolment in a research higher degree.

A masters thesis is normally taken in the final two semesters of study and develops research, communication and technical skills. An in-depth investigation of a particular area is completed under the guidance of a supervisor and students can opt to research advanced areas within the discipline.

STUDY PROGRAM
The topics involve both course work and research components with core topics focusing on professional studies. These include nuclear and quantum physics and standards, ethics and compliance. In addition to the core topics, students can choose electives including partial differential equations, methods of applied mathematics and complex analysis.

CAREER OUTCOMES
Career options exist in areas such as optics, telecommunications, instrumentation development, acoustics, research and development laboratories and geophysics.

FURTHER COURSE INFORMATION >> flinders.edu.au/courses/postgrad/scphy

CIRCOS Code: 083454E

*Students with a Bachelors degree in the same discipline may be eligible for a 1.5 year full-time program.

Entry requirements: Applicants must normally hold an approved Bachelor’s degree or equivalent with a major in Physics or a closely related discipline from an approved institution. A knowledge of at least second year physics and mathematics is assumed. The Faculty Board may, under certain circumstances and subject to specific conditions, admit others who can show evidence of fitness of candidature. The Masters of Science is not available to students who hold an Honours degree in the same discipline.
This program in Primary Health Care has been designed for health professionals seeking specialist qualifications with vocational relevance. The aim is to enhance their knowledge and skills in ways that enable them to better plan, develop, manage and evaluate initiatives and programs to promote health and prevent diseases. The Graduate Certificate aims to provide students with the knowledge and skills to incorporate the principles of primary health care in order to reduce the inequalities in health care access and health outcomes. This course articulates with the Master of Public Health.

STUDY PROGRAM
Topics undertaken as part of Primary Health Care in Developing Countries may include:

> Social Determinants of Health and Wellbeing
> Primary Health Care Practice in Developing Countries

CAREER OUTCOMES
Students graduate fully equipped with the knowledge and skills required to incorporate the principles of primary health care into specific fields of practice. Graduates typically gain employment in areas promoting health and disease prevention, improving health care access and outcomes in both developing and developed countries. Graduates can go on to gain employment in a number of fields and settings including government departments and non-government agencies internationally.

FURTHER COURSE INFORMATION
flinders.edu.au/courses/postgrad/gphcpcdc
CRICOS Code: 073815A

Entry requirements: Bachelor degree or equivalent from an approved tertiary institution.
Public Health
Graduate Certificate in Health Promotion; Graduate Certificate in Public Health; Master of Public Health

Research Methods
Graduate Diploma in Research Methods

Entry requirements:
Graduate Certificate: Bachelor degree or equivalent. Masters: Bachelor degree in a related field.

This unique course provides students with high-level knowledge and skills in research methods as a pathway towards further learning at research higher degree level.

Students may choose to exit from the Graduate Diploma in Research Methods with the exit award of the Graduate Certificate in Research Methods, provided that they have met the requirements for that award.

The Graduate Diploma in Research Methods is designed to provide you with high-level knowledge of and skills in research methods and the opportunity to develop further depth and breadth of knowledge in your area of study as a pathway to research higher degree study (conditions apply).

It includes a substantial 18-unit research thesis/project, which provides the eligibility required to apply for various scholarship opportunities and entry into a research higher degree (conditions apply).

Study Program
This course can be pursued in most disciplines of the university (with the exception of Psychology).

Career Outcomes
Graduates are suitable for careers in areas such as the government sector, private or corporate consulting sectors and research institutions.

Further Course Information
flinders.edu.au/courses/rules/postgrad/gdprm.cfm
CRICOS Code: Graduate Diploma – 089512D

Screen and Media Production
Graduate Certificate in Screen and Media Production; Graduate Diploma in Screen and Media Production; Master of Screen and Media Production

Entry requirements:
Graduate Certificate and Graduate Diploma: An approved bachelor degree or equivalent qualification from an approved tertiary institution and have achieved a grade point average of 5.00 or greater. Under exceptional circumstances and subject to specific conditions, the Faculty Board may admit others who can show evidence of fitness for candidates. This course is unsuitable for the School of Psychology due to accreditation and topic prerequisites.

This course provides students with an understanding of the fields of screen and media production and practice skills; research and writing skills in screen studies; and a practical understanding of professional activities in a related field of study. In addition, the Master of Screen and Media Production provides you with an in-depth knowledge of a specific area of screen production, obtained through a combination of coursework and research; vocational knowledge and skills in the fields of screen production; and increased specialisation within a systematic and coherent body of knowledge relating to documentary film-making, digital media and screen studies.

Industry experience: Students have the opportunity to undertake a practicum.

Study Program
Topics taken may include:
> Production
> Post-Production
> Minor Project
> Research and Writing
> Documentary Camera
> Major Project Script and Pre-Production
> Non-fiction Form and Ethics
> 3D Animation and the Screen

Career Outcomes
This articulated course is intended to provide students with knowledge and skills to enter a range of professional roles including presenter, broadcast monitor, filmmaker, content strategist, creative writer, media advisor, multimedia researcher, production coordinator and video journalist. Employment opportunities exist in a varied range of sectors including community groups, industry, education media, film and TV production companies, publishers, advertisers, and arts organisations.

Further Course Information
flinders.edu.au/courses/rules/postgrad/screenmedia
CRICOS Code: Graduate Certificate – 071843B. Graduate Diploma – 071844A; Masters – 071845M; Masters Advanced 1 year – 089593B; Masters Advanced 1.5 years – 089594A

Social Work
Master of Social Work

Entry requirements:
There are two points of entry into the Master of Social Work. 1. Applicants who have completed a bachelor’s degree are eligible to apply for entry to the Master of Social Work (Graduate Entry). 2. Applicants who have completed a Bachelor of Social Work degree recognised by the Australian Association of Social Work (AASW) or equivalent are eligible to apply for entry to the Master of Social Work (Qualified Social Work Entry). Applicants for the MSW (Qualified) must have completed either (a) an AASW-accredited Bachelor of Social Work Honours or (b) an AASW-accredited Bachelor of Social Work plus at least 2 years professional work experience (paid or volunteer) or equivalent.

Note: Some topics are taught in intensive delivery mode. As per Australian Government regulations, courses have a placement involving contact with children, young people and for vulnerable adults. Please students to undergo an Officer History Record Check prior to placement.

The Master of Social Work is a coursework program designed to provide a higher degree coursework masters award following a knowledge and skills-based curriculum. The Master of Social Work is available via the Australian Government regulations, courses that have a placement involving contact with children, young people and vulnerable adults. Please students to undergo an Officer History Record Check prior to placement.

Industry experience: Students will undertake two field placements, totalling 500 hours each, with opportunities for overseas placements. These placements are designed to provide students with learning opportunities in a range of practice settings, with varied practice methodologies and different client groups.

Professional accreditation: Master of Social Work graduates are eligible for membership with the Australian Association of Social Workers (AASW). Students must have completed an accredited degree and also meet the AASW English language requirements.

Study Program
Topics you may study include:
> Social Work with Diverse Populations
> Complexities in Work with Children and Families
> Mental Health through the Life Course
> Trauma and Resilience

Career Outcomes
Graduates can go on to secure positions in a variety of settings within a framework of relevant legislation and policies, supporting individuals, families, and groups within the community. Potential roles include community services project officer, case manager, advocacy worker, mental health worker, social research officer and youth pathways project officer. Social workers are employed in governmental departments, hospitals, and community centres, correctional services and welfare agencies.

Further Course Information
flinders.edu.au/courses/rules/postgrad/msw
CRICOS Code: 019223G
Speech pathologists provide professional services for persons across the lifespan whose educational, vocational, personal and social functioning is impaired by disorders of speech, language, voice, swallowing, fluency and hearing. Communication and swallowing disabilities may severely impact people’s quality of life and result from developmental difficulties, social disadvantage, illness or accident. Our award winning teaching staff work closely with the speech pathology profession to ensure that our graduates are well equipped to enter the diverse and interesting profession. This coursework program uses an innovative, inquiry-based curriculum, incorporating a problem-based learning format.

Industry experience: You will undertake extensive clinical experience throughout the two years. Placement in the first 5 weeks of the program. Placements may be in Adelaide, country areas of South Australia or the Northern Territory, and in some circumstances, overseas.

Professional accreditation: Graduates will meet the entry-level standards of Speech Pathology Australia (SPA), the national accrediting body, which will enable them to practise in Australia and many other countries around the world including the UK and Asia.

STUDY PROGRAM

Topics studied as part of this program include:
> Professional Studies and Communication Sciences
> Speech Pathology Skills and Practice
> Research Methods

CAREER OUTCOMES

Speech pathology graduates are employed in a wide range of settings and work with people of all ages, their families, schools, communities and other professionals across a wide variety of agencies. These include schools, hospitals, aged care services, universities, early childhood services, rehabilitation centres, community health centres, private practices and mental health services.

This course has a specific application deadline. Please contact the International Centre at internationalapply@flinders.edu.au for more information.

FURTHER COURSE INFORMATION

> flinders.edu.au/courses/postgrad/mssp

CRICOS Code: 05430D

STUDY PROGRAM

Early Childhood topics may include:
> Making Meaning in the Expressive Arts
> The Numerate and the Literate Infant
> Thinking and Working Scientifically in the Early Years
> Pedagogies of Belonging

Primary R-7 topics may include:
> Teaching In and Through the Expressive Arts
> Researching Learners and Learning
> Introduction to Teaching and Research in the Education Profession

Secondary topics may include:
> Curriculum Studies: Developing Curriculum in Context in the Middle Years
> Understanding Curriculum Development
> Professional Issues in Secondary Education
> Literacies for the Middle and Secondary Years

Special Education topics may include:
> Interventions for students with literacy difficulties
> Teaching In and Through the Expressive Arts
> Supporting Positive Behaviour in Schools
> Assessment in Education

Professional accreditation: Graduates will be provided with an academic qualification that will enable them to apply for registration with the Teachers Registration Board of South Australia, interstate and some overseas countries (exact requirements may vary).

CAREER OUTCOMES

Master of Teaching (Early Childhood/ Primary R-7/Secondary/ Special Education) prepares graduates to enter the teaching profession with confidence and competence. Graduates are suitable for careers as teachers in early childhood centres, primary schools and secondary schools, and as special education teachers. Although the majority of education graduates go on to employment as a teacher in the public or private sector, some choose to follow other pathways. Graduate roles include community education officer, and education and engagement officer.

FURTHER STUDY

Graduates can pursue further study by undertaking a Doctor of Education.

FURTHER COURSE INFORMATION

> flinders.edu.au/courses/postgrad/mtec

CRICOS Code: 063695J. Primary R-7 ~ 063696G. Secondary ~ 063697G. Special Education ~ 063698F

> flinders.edu.au/courses/postgrad/mltp

> flinders.edu.au/courses/postgrad/mnts

CRICOS Code: 063865J. Primary R-7 ~ 063866G. Secondary ~ 063867G. Special Education ~ 063868F

> flinders.edu.au/courses/postgrad/mlte

These courses are aimed at the development of skills in the area of Teaching English as a Second Language (TESOL). They are also designed to facilitate the development of disciplinary knowledge in the area of second language acquisition, as well as specific knowledge in the area of TESOL. The combination of theoretical knowledge and teaching methodology equips prospective TESOL practitioners with tools for classroom practice. The flexibility of delivery of the four topics in the Graduate Certificate in Teaching English as a Second Language will cater for graduates who do not have a formal teaching qualification and wish to teach English as a second language; qualified teachers who require specialised knowledge in TESOL; or qualified teachers of other subjects, who are taught using English as the language of instruction.

STUDY PROGRAM

Topics studied may include:
> Second Language Learning and Teaching
> Second Language Testing
> Introduction to English Linguistics
> TESOL Methodology
> English as a Global Language
> Directed Studies in TESOL
> Cross-cultural Pragmatics and Intercultural Communication

CAREER OUTCOMES

With the internationalisation of the job market, graduates with a qualification in a foreign language teaching will have greater employment opportunities. Graduates are suitable for careers teaching English at private language colleges, schools, or university language centres (subject to employer requirements). Potential roles include English language teacher, assistant language teacher, communications specialist, immigration officer, international student advisor, interpreter, linguistic service officer, translator and travel consultant.

FURTHER COURSE INFORMATION

> flinders.edu.au/courses/postgrad/mlsl

### THEOLOGICAL STUDIES
Graduate Certificate in Theological Studies; Graduate Diploma in Theological Studies; Master of Theological Studies

<table>
<thead>
<tr>
<th>Course length:</th>
<th>Graduate Certificate: 6 months full-time</th>
<th>Graduate Diploma: 1 year full-time</th>
<th>Masters: 2 years full-time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intake:</td>
<td>Semester 1 + Semester 2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Entry requirements:
- Graduate Certificate: Bachelor degree or equivalent from an approved tertiary institution.

This course is designed to provide a sound understanding of contemporary theology and biblical studies and to provide opportunities to reflect on theological dimensions of professional and social life. The course is suitable for professionals in the field of religion or related disciplines, and people with a general interest in religion. The Graduate Diploma of Theological Studies expands a student's investigation of a range of theological and biblical studies. The Master of Theological Studies offers students the opportunity to extend their knowledge and skills in a particular area of theological study and to undertake a research project on a theme of relevance to their own professional work.

#### STUDY PROGRAM
Topics undertaken as part of this program may include:
- Theology of Jesus Christ
- Interpretation of the Old Testament
- Introduction to Christian Thought
- Biblical Hermeneutics
- Interpreting the New Testament

#### CAREER OUTCOMES
Theology graduates work in a variety of different roles in many employment sectors. Graduates are suitable for careers as teachers of religious education and other professional positions in the field of religion. Potential roles include higher education lecturer, primary school teacher or secondary school teacher, social researcher, youth worker, charity officer and international aid/development worker. Potential employers include public and private sector organisations, universities, financial firms, legal organisations and government agencies. Graduates may work in administration, financial and general management positions, libraries, charities, television companies and publishing houses also employing theology graduates in different roles.

### TOURISM
Graduate Diploma in Tourism; Master of Tourism

<table>
<thead>
<tr>
<th>Course length:</th>
<th>Graduate Diploma: 1 year full-time</th>
<th>Masters: 2 years full-time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intake:</td>
<td>Semester 1 + Semester 2</td>
<td></td>
</tr>
<tr>
<td>Opportunity for industry experience</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Entry requirements:
- Graduate Diploma: Bachelor degree or equivalent in a major in Tourism or related discipline. Masters: Bachelor degree or equivalent qualification in Tourism, Hospitality or a related discipline from an approved tertiary institution with a GPA of 5.0 in upper level topics; or a Graduate Diploma in Tourism, or equivalent qualification from an approved tertiary institution, with a GPA of 5.0; or an honours degree in Tourism or a closely related discipline from an approved tertiary institution.

This course provides you with a broad understanding of tourism, both in Australia and worldwide; enables you to implement research concepts to examine the arts, culture and heritage of a place; and allows you to benefit from our strong links to the tourism industry and industry-focused core topics.

#### Industry experience:
Industry based practicum and research.

#### STUDY PROGRAM
Topics you may study as part of the Tourism stream include those related to tourism management, site interpretation and research skills.

#### CAREER OUTCOMES
Potential roles include business development manager, cultural tourism officer, events and sponsorship manager, corporate groups consultant and tourism marketing. Graduates are suitable for careers in areas such as market planning, advertising and promotion, brochure production and tour planning. Employers include travel agencies, airlines, convention/exhibition centres and government.

### WATER RESOURCES MANAGEMENT
Graduate Certificate in Science (Water Resources Management); Graduate Diploma in Science (Water Resources Management); Master of Science (Water Resources Management)

<table>
<thead>
<tr>
<th>Course length:</th>
<th>Graduate Certificate: 6 months full-time</th>
<th>Graduate Diploma: 1 year full-time</th>
<th>Masters: 2 years full-time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intake:</td>
<td>Semester 1 + Semester 2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Entry requirements:
- Bachelor degree or equivalent in a relevant discipline of science and engineering, from an approved tertiary institution.

These programs aim to train students to understand the scientific problems involved with the management of water. Our Water Resources Management programs are designed to meet the needs of students from different scientific disciplines and provide real flexibility both in terms of content and modes of delivery. The program offers a number of streams which can be blended to produce either a degree of significant depth or a much broader program with generalised understanding of a wide range of water resources management subjects.

We train you to apply management fundamentals to solve current problems and to anticipate, mitigate and prevent future problems in the area of water resources management. Masters students have the opportunity to undertake a major research project or a minor research project combined with an industry placement.

#### STUDY PROGRAM
Topics undertaken may include:
- Fundamentals of Groundwater
- Ecohydrology
- Public Health Aspects of Water Quality
- Geographical Information Systems
- Project Management

(Please note, some topics are only offered externally. Students are encouraged to check visa requirements and compliance before enrolling in external topics.)

#### CAREER OUTCOMES
Graduates of these programs will be equipped for employment with government departments; engineering, environmental and water management consultancies; water management bodies; local government; aid organisations; commercial organisations; and agricultural organisations.

### Further Course Information
- [www.flinders.edu.au/courses/postgrad/wrm](http://www.flinders.edu.au/courses/postgrad/wrm)

CIRCOCS Code: Graduate Diploma – 059257K, Masters – 059258J.
## 2018 Postgraduate Course Index

<table>
<thead>
<tr>
<th>CRICOS</th>
<th>2018 Fee (AUD)</th>
<th>Course Duration</th>
<th>SEMESTER 1/2</th>
<th>IELTS (Academic)</th>
<th>TOEFL (Internet)</th>
</tr>
</thead>
</table>

### Environmental Health

<table>
<thead>
<tr>
<th>CRICOS</th>
<th>2018 Fee (AUD)</th>
<th>Course Duration</th>
<th>SEMESTER 1/2</th>
<th>IELTS (Academic)</th>
<th>TOEFL (Internet)</th>
</tr>
</thead>
</table>

### Environmental Management

<table>
<thead>
<tr>
<th>CRICOS</th>
<th>2018 Fee (AUD)</th>
<th>Course Duration</th>
<th>SEMESTER 1/2</th>
<th>IELTS (Academic)</th>
<th>TOEFL (Internet)</th>
</tr>
</thead>
</table>

### Gender, Development and Women's Studies

<table>
<thead>
<tr>
<th>CRICOS</th>
<th>2018 Fee (AUD)</th>
<th>Course Duration</th>
<th>SEMESTER 1/2</th>
<th>IELTS (Academic)</th>
<th>TOEFL (Internet)</th>
</tr>
</thead>
</table>

### Gender Mainstreaming Policy and Analysis

<table>
<thead>
<tr>
<th>CRICOS</th>
<th>2018 Fee (AUD)</th>
<th>Course Duration</th>
<th>SEMESTER 1/2</th>
<th>IELTS (Academic)</th>
<th>TOEFL (Internet)</th>
</tr>
</thead>
</table>

### Geology

<table>
<thead>
<tr>
<th>CRICOS</th>
<th>2018 Fee (AUD)</th>
<th>Course Duration</th>
<th>SEMESTER 1/2</th>
<th>IELTS (Academic)</th>
<th>TOEFL (Internet)</th>
</tr>
</thead>
</table>

### Geospatial Information Science (GIS)

<table>
<thead>
<tr>
<th>CRICOS</th>
<th>2018 Fee (AUD)</th>
<th>Course Duration</th>
<th>SEMESTER 1/2</th>
<th>IELTS (Academic)</th>
<th>TOEFL (Internet)</th>
</tr>
</thead>
</table>

### Global Point-of-Care Testing

<table>
<thead>
<tr>
<th>CRICOS</th>
<th>2018 Fee (AUD)</th>
<th>Course Duration</th>
<th>SEMESTER 1/2</th>
<th>IELTS (Academic)</th>
<th>TOEFL (Internet)</th>
</tr>
</thead>
</table>

For notes on entry requirements, please see pg 85
# 2018 Postgraduate Course Index

<table>
<thead>
<tr>
<th>Code</th>
<th>Name of Course</th>
<th>CRICOS</th>
<th>2018 Fee (AUD)</th>
<th>Duration</th>
<th>Intake</th>
<th>Semester</th>
<th>Speaking</th>
<th>Writing</th>
<th>Reading</th>
<th>Listening</th>
<th>Overall</th>
<th>B2</th>
<th>C 65*</th>
</tr>
</thead>
<tbody>
<tr>
<td>088951C</td>
<td>Master of Nursing (Global Health Care)</td>
<td>31,300</td>
<td>1.5 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>60</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 65*</td>
</tr>
<tr>
<td>088950D</td>
<td>Graduate Diploma in Nanotechnology</td>
<td>33,000</td>
<td>1 S1/S2</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>80</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>089423A</td>
<td>Master of Nursing (Nursing)</td>
<td>30,500</td>
<td>1 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>80</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>089424A</td>
<td>Graduate Diploma in Nursing (Global Health Care)</td>
<td>31,300</td>
<td>1.5 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>60</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>089445A</td>
<td>Master of Nursing (Primary Health Care)</td>
<td>31,300</td>
<td>1 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>80</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>089446G</td>
<td>Graduate Diploma in Primary Health Care</td>
<td>31,300</td>
<td>1.5 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>60</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>089447A</td>
<td>Master of Nursing (Coursework and Research)</td>
<td>31,300</td>
<td>1.5 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>80</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>088943C</td>
<td>Master of Nursing (Acute Care)</td>
<td>31,300</td>
<td>1.5 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>80</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>089560D</td>
<td>Graduate Diploma in Nursing (Global Health Care)</td>
<td>31,300</td>
<td>1 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>80</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>089561C</td>
<td>Master of Nursing (Primary Health Care)</td>
<td>31,300</td>
<td>1.5 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>60</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>089548J</td>
<td>Master of Nursing (Primary Health Care)</td>
<td>31,300</td>
<td>1 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>80</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>088944G</td>
<td>Graduate Diploma in Nanotechnology</td>
<td>31,300</td>
<td>1 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>80</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>085903B</td>
<td>Graduate Certificate in Palliative Care</td>
<td>26,800</td>
<td>1 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>80</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>085904A</td>
<td>Graduate Certificate in Palliative Care</td>
<td>26,800</td>
<td>1.5 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>60</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>085905M</td>
<td>Graduate Certificate in Palliative Care</td>
<td>26,800</td>
<td>1 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>80</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>085906A</td>
<td>Graduate Certificate in Palliative Care</td>
<td>26,800</td>
<td>1.5 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>60</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>085907A</td>
<td>Graduate Certificate in Palliative Care</td>
<td>26,800</td>
<td>1 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>80</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>085908A</td>
<td>Graduate Certificate in Palliative Care</td>
<td>26,800</td>
<td>1.5 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>60</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>085909A</td>
<td>Graduate Certificate in Palliative Care</td>
<td>26,800</td>
<td>1 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>80</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>085910A</td>
<td>Graduate Certificate in Palliative Care</td>
<td>26,800</td>
<td>1.5 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>60</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>085911A</td>
<td>Graduate Certificate in Palliative Care</td>
<td>26,800</td>
<td>1 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>80</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>085912A</td>
<td>Graduate Certificate in Palliative Care</td>
<td>26,800</td>
<td>1.5 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>60</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>090602D</td>
<td>Master of Occupational Therapy</td>
<td>32,200</td>
<td>2 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>60</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>059257K</td>
<td>Graduate Diploma in Nutrition and Dietetics</td>
<td>26,800</td>
<td>1 S1</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>80</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>051844M</td>
<td>Master of Psychology (Clinical)</td>
<td>31,600</td>
<td>1 S1</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>80</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>089289J</td>
<td>Master of Public Administration</td>
<td>31,300</td>
<td>1 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>80</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>089290A</td>
<td>Graduate Certificate in Public Policy</td>
<td>26,800</td>
<td>1 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>80</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>089291F</td>
<td>Graduate Certificate in Public Sector Management</td>
<td>26,800</td>
<td>1 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>80</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>089292A</td>
<td>Graduate Diploma in Public Administration</td>
<td>26,800</td>
<td>1 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>80</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>089293A</td>
<td>Master of Public Administration</td>
<td>26,800</td>
<td>1 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>80</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
<tr>
<td>089294A</td>
<td>Master of Public Administration (Management)</td>
<td>26,800</td>
<td>1 S1/S2</td>
<td>6.5</td>
<td>6</td>
<td>6</td>
<td>80</td>
<td>18</td>
<td>18</td>
<td>18</td>
<td>6</td>
<td>B2</td>
<td>C 50*</td>
</tr>
</tbody>
</table>

For notes on entry requirements, please see pg 85
### 2018 Research Higher Degrees (Masters)

| DEGREES (PHD) | CRICOS | 2018 FEE (AUD) | COURSE | DURATION | INTAKE | IELTS (ACADEMIC) | TOEFL (INTERNET) | OVERALL | SEMESTER 1 | SEMESTER 2 | SEMESTER 3 | SEMESTER 4 | SEMESTER 5 | SEMESTER 6 | SEMESTER 7 | SEMESTER 8 | SEMESTER 9 | SEMESTER 10 | SEMESTER 11 | SEMESTER 12 | CRICOS | ENGLISH REQUIREMENTS |
|----------------|--------|----------------|--------|----------|--------|----------------|-----------------|--------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|----------|------------------|
| PhD (Biological Sciences) | 033497C | 32,300 | 4 | SI/S2 | 6.5 | 6.5 | 6 | 80 | 18 | 18 | 18 | 18 | 18 | C | 58* |
| PhD (Chemistry) | 053045D | 32,300 | 4 | SI/S2 | 6.5 | 6.5 | 6 | 80 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | C | 58* |
| PhD (Clinical Psychology) | 039996G | 31,600 | 4 | SI/S2 | 7 | 7 | 7 | 7 | 96 | 24 | 24 | 24 | 24 | C | 65* |
| PhD (Computer Sciences) | 004693M | 32,300 | 4 | SI/S2 | 6.5 | 6.5 | 6 | 80 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | C | 58* |
| PhD (Economics) | 010651D | 29,900 | 4 | SI/S2 | 6.5 | 6.5 | 6 | 80 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | C | 58* |
| PhD (Engineering) | 013304F | 31,600 | 4 | SI/S2 | 6.5 | 6.5 | 6 | 80 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | C | 58* |
| PhD (Environmental Health) | 073505G | 31,000 | 4 | SI/S2 | 6.5 | 6.5 | 6 | 80 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | C | 58* |
| PhD (Environmental Studies) | 073614K | 28,200 | 2 | S1/S2 | 6.5 | 6.5 | 6 | 80 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | C | 58* |
| PhD (Geography and Population Studies) | 073349M | 28,200 | 2 | S1/S2 | 6.5 | 6.5 | 6 | 80 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | C | 58* |
| PhD (Health Administration) | 023594A | 29,900 | 2 | S1/S2 | 6.5 | 6.5 | 6 | 80 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | C | 58* |
| PhD (Mathematics/Statistics) | 002644C | 32,300 | 2 | S1/S2 | 6.5 | 6.5 | 6 | 80 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | C | 58* |
| PhD (Medical Sciences) | 053045D | 32,300 | 2 | S1/S2 | 6.5 | 6.5 | 6 | 80 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | C | 58* |
| PhD (Medical Sciences/Biostatistics) | 003201D | 32,300 | 4 | SI/S2 | 6.5 | 6.5 | 6 | 80 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | C | 58* |
| PhD (Medical Public Health) | 053046C | 29,900 | 4 | SI/S2 | 6.5 | 6.5 | 6 | 80 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | C | 58* |
| PhD (Nursing/Midwifery) | 010651D | 29,900 | 4 | SI/S2 | 6.5 | 6.5 | 6 | 80 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | C | 58* |
| PhD (Physical Sciences) | 003487C | 32,300 | 2 | S1/S2 | 6.5 | 6.5 | 6 | 80 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | C | 58* |
| PhD (Psychology) | 089935A | 33,000 | 4 | SI/S2 | 6.5 | 6.5 | 6 | 80 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | C | 58* |
| PhD (Theology) | 053048M | 26,000 | 4 | SI/S2 | 6.5 | 6.5 | 6 | 80 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | 18 | C | 58* |

### Notes

#### General Notes

- **2018 Tuition Fee**: For a standard load of 36 units per year. The quoted fee is a base fee that will be subject to an annual increase that is at least the rate of inflation, but no more than 3%, for each of the subsequent years of the program. The University’s Student Services and Amenities fee for international students is included in the tuition fee. The fee covers the cost of teaching and student support services.

- **(PT) Part-time**: International students cannot undertake external or part-time study while in Australia on a student visa.

#### International Student Policy

The International Student policy and procedures statement details the specific provisions which apply to international students undertaking a Flinders University course, except where that course is offered by another institution on behalf of the University. In such instances, the other institution’s policies and procedures will apply. The statement can be found at flinders.edu.au/ppmanual/student/international-students.cfm.

It is important that students read and understand these provisions prior to accepting their offer at Flinders University. Specific provisions include:

- The University’s commitment to working under the Education Services for Overseas Students (ESOS) Act and National Code (2007)

- The University’s commitment to working within the Code of Practice in the Provision of Education to International Students

- English language proficiency requirements

- Admissions policies for international undergraduate, postgraduate, Study Abroad and Exchange students including basis of admission, and assessment of qualifications

- tuition fees, the payment of tuition fees, and refund policies

- Duration of study, deferrals, suspension, and cancellation of student’s enrolment policies
The following pages provide a summary of the application process. For more detailed information, visit our website:
international.flinders.edu.au
To enrol at Flinders as a postgraduate student you must meet the following academic and English language proficiency requirements for admission:

**ACADEMIC ENTRY REQUIREMENTS**

For graduate certificates, graduate diplomas and masters programs:
- For most degrees you must have satisfactorily completed a degree considered comparable to an Australian bachelors degree.
- Some degrees may require work experience to meet the entry requirements. A reference or statement from your employer will be required.

For masters by research and doctor of philosophy (PhD):
- For admission to a research higher degree program, you normally need an Honours Class 1 or 2A degree or equivalent, although other qualifications may be considered.
- Direct entry into a PhD is also dependent on the strength of your research background and you may be required to undertake a qualifying program if your research profile is not considered sufficient.

Some specific courses have additional entry requirements. These can be found at: flinders.edu.au/postgrad/apply

**ENGLISH LANGUAGE ENTRY REQUIREMENTS**

For applicants whose first language is not English, you will need to have:
- achieved the required test score for your course as listed in the course index at the back of this publication. Test results must be no more than two years old on the proposed date of commencement of the course; or
- successfully completed an approved secondary or tertiary qualification, taught in the English language in a country where Flinders recognises English as the official language or the main language spoken (for up to an overall IELTS of 6.5), with evidence no more than five years old on the proposed date of commencement of the course; or
- successfully completed a pre-course English program from an approved ELICOS provider (evidence of completion must be no more than two years old on the proposed date of commencement of the course).

Other evidence of English language proficiency may be accepted.

For more information visit:
flinders.edu.au/englishrequirements

**PATHWAYS TO FLINDERS**

Don’t meet our academic or English language entry requirements? There are other pathways to Flinders.

Applicants who do not meet our English language requirements and need to improve their proficiency can do so through our approved English language (ELICOS) providers. This means you can attend the required English language tuition at approved ELICOS providers and gain direct entry into Flinders once meeting the required level, without having to sit an IELTS or TOEFL test.

Flinders’ approved ELICOS providers include:
- Flinders International Study Centre
  isc.flinders.edu.au
- Intensive English Language Institute (IELI) located on campus at Flinders
  ieli.sa.edu.au
- Eynesbury College
  eynesbury.navitas.com
- English College of Adelaide
  eca-jca.edu.au
- South Australian College of English
  (SACE) sacecoll.sa.edu.au

For more information, please visit:
flinders.edu.au/international/pathways

**PATHWAY TO A RESEARCH HIGHER DEGREE**

We offer a Graduate Diploma in Research Methods as a pathway to a research higher degree.

For more information, please see page 72 of this guide, or visit:
flinders.edu.au/graduate-research/pathways

**PRE-MASTERS BUSINESS PROGRAM AT FLINDERS INTERNATIONAL STUDY CENTRE**

CRICOS Code: Accelerated - 085891A
CRICOS Code: Standard - 085892M

Specifically designed for international students, the Pre-Masters Business Program is an advanced course of English language and academic preparation. The course will fully prepare you for joining the Master of Business, Master of Accounting or Master of Accounting and Finance degree at Flinders University.

For more information, please visit:
isctechnologies.com.au
flinders.edu.au/international/pathways

**ENTRY REQUIREMENTS**

**PATHWAYS TO FLINDERS**
Our admission process is a simple four-step process.

1. **YOUR APPLICATION**
   - Submit your application, making sure you include all the required documents as attachments.
   - Once your application is received by Flinders University International Centre, you will be sent an acknowledgement of your application being received and we will advise you if any further information or documentation is required.

2. **YOUR OFFER OF ADMISSION**
   - Your offer of admission is usually sent to you by email. If you do not have an email address we will post the offer letter directly to you or email your agent. We will endeavour to send your offer letter within 10-14 working days, however there may be delays where you have applied for a course with strict quotas or additional entry requirements, or where credit/exemption is sought for previous study.
   - Included in the offer of admission is a weblink to ‘Your Offer Letter Explained’. At this stage you will be required to accept the offer by completing the acceptance form.
   - We will advise you if any further information or documentation is required.

3. **CONFIRMATION OF ENROLMENT**
   - We will issue the Confirmation of Enrolment (COE) upon receipt of the signed acceptance, review of the declaration, and payment of fees and OSHC.
   - With the COE you can apply for your student visa. Please check your visa requirements at: border.gov.au

4. **ARRIVAL AND ORIENTATION**
   - Pre-arrival information to assist you prior to your departure for Adelaide is also available in the International Student Handbook at: flinders.edu.au/international/services
   - Flinders University has a network of agents situated in more than 400 offices around the world. We encourage you to talk to someone face-to-face about your unique situation to ensure that any information you get is tailored specifically for your needs.
   - Agents can provide you with:
     - answers to specific questions that relate to your own situation
     - up-to-date and intensive education counselling
     - assistance in application and visa processing
     - pre-departure and arrival assistance
     - IELTS and TOEFL support
     - assistance with travel arrangements, including obtaining a student visa
   - For more information visit: flinders.edu.au/international/

If you require support submitting your application please contact us via our website or contact an agent in your country.

Looking to apply for a course at Flinders? Follow our step-by-step guide to help you through the application process.

**APPLYING THROUGH AN AGENT**

- Flinders University offers a wide range of postgraduate and research programs. When choosing your course there is a lot for you to consider. What type of course should you do, what qualification will you get at the end and what are your career goals? Take the time to research which course suits your ambitions best.

**APPLICATION FEE**

- An application fee of AUD$60 is required upon submission of the online application. If you need assistance completing the online application form you may wish to contact the International Centre or one of our authorised agents who will be happy to help you.
- The University does not charge an application fee if you submit online via an agent. See our website for details: flinders.edu.au/international

**STEP 1 SELECT YOUR COURSE OR PROGRAM**

- Flinders University offers a wide range of postgraduate and research programs. When choosing your course there is a lot for you to consider. What type of course should you do, what qualification will you get at the end and what are your career goals? Take the time to research which course suits your ambitions best.

**STEP 2 CHECK ENTRY REQUIREMENTS**

- Decided which course you would like to apply for? You will need to check that you meet our entry requirements. If you do not meet these requirements there are still options available to you. Why not consider enrolling in one of our pathway or preparatory programs? Please visit our website for further information: flinders.edu.au/international/pathways

**STEP 3 COMPLETE AND SUBMIT AN APPLICATION FORM**

- Selected a course?
- Met our entry requirements?
- Checked credit transfer eligibility?
- You are now ready to complete our application form. You can apply online simply by clicking the ‘apply’ button at: flinders.edu.au/international

**NOTE: EXTERNAL COURSES**

- International students cannot undertake external courses while in Australia on a student visa.

**RESEARCH DEGREES**

- You need to think about possible research projects and topics that align with your interests, qualifications and experience. Please view: flinders.edu.au/expertise
- Fill in the online Expression of Interest form at: flinders.edu.au/courses/rdinterest
- Once your research area is confirmed, you can lodge a full application with the university. The university will advise you of the outcome.

**WHEN TO APPLY**

- Applications can be made at any time during the year to available course intakes. Admission to some programs is very competitive as places are limited. Some courses have specific application deadlines. Please contact the International Centre for more information.
ACADEMIC ENGLISH PREPARATION (AEP)  
Program aimed at improving your English language and academic skills prior to commencing study at Flinders University.

ACADEMIC STAFF  
All teaching and research staff, including professors (the most senior), associate professors or readers, senior lecturers, lecturers, associate lecturers and tutors.

ACADEMIC YEAR  
 Begins in late February or early March and ends in late November.

AUSTRALIAN CENTRAL STANDARD TIME (ACST)  
Time zone for Adelaide and South Australia.

AWARD  
A degree, certificate, diploma, masters or PhD of the University granted at the completion of a course of study.

BACHELOR DEGREE  
Normally the basic (first) undergraduate degree.

CENTRAL BUSINESS DISTRICT (CBD)  
The commercial and business centre of a city.

CONFIRMATION OF ENROLMENT (COE)  
A COE is a document provided by the University to an international student who studies in Australia on a student visa. It confirms that an international student is eligible to enrol in a course. You do not need a COE if you are a local student, or an international student studying in Australia on an AustrAID Scholarship, or on a temporary residence or permanent residence visa.

CORE TOPICS  
Compulsory subjects that form the basis of a study program.

COURSE  
A program of study leading to a degree or diploma.

COURSE COORDINATOR  
The staff member who is responsible for a particular course. The course coordinator is your main contact person at the university. The course coordinator will advise you on matters like enrolment, topic selection, study program, and problems with study. The course coordinator consults with Enrolment Services in authorising your enrolment in topics, amendment of enrolment study. The course coordinator consults with Enrolment Services the staff member who is responsible for a particular course.

FOUNDATION PROGRAM  
The Foundation Program is a comprehensive academic program which prepares students for university-level learning.

GRADUATE  
A person who has received his or her degree.

GRADUATION  
A ceremony at which degrees are conferred and diplomas awarded, and is usually held in April and December.

HONOURS DEGREE  
Awarded to undergraduate students who choose to complete an additional year of study. In the case of four-year degree programs, honours may be awarded to students who perform particularly well.

INTERNATIONAL ENGLISH LANGUAGE TESTING SYSTEM (IELTS)  
Measures the language proficiency of people who want to study or work where English is used as a language of communication.

INNOVATIVE RESEARCH UNIVERSITIES (IRU)  
A global consortium comprised of higher education institutions that actively seek international partnerships and experiences, create innovative programming and delivery methods, and embrace the internationalisation movement.

INTERNATIONAL NETWORK UNIVERSITIES (INU)  
A network of 6 comprehensive universities across Australia committed to inclusive excellence in teaching and research.

INTERNATIONAL SERVICES (IS)  
The on-campus student organisation that exists for the purpose of representing students’ rights and interests.

INTERNATIONAL STUDENT BAROMETER (ISB)  
The global benchmark for the international student experience conducted by Internationals.

INTENSIVE  
Where a topic is studied over a short period of time (eg week or weekend) with the same number of contact hours as a semester length topic.

INTERNATIONAL STUDENT SERVICES (ISS)  
International Student Services (ISS) is the first point of contact for international students and offers a range of programs supporting your enrolment, study and social life, as well as a referral service to facilities on campus and within the local community.

MAJOR SEQUENCE  
A sequence of topics that must be taken in all three years of a degree.

MINOR SEQUENCE  
A small number of topics in one area of study.

NEW VENTURE INSTITUTE (NVI)  
New Venture Institute is the centre of innovation and entrepreneurship at Flinders University. Through programs and activities they aim to inspire, connect and educate future generations of entrepreneurs and innovators.

PEARSONS TEST OF ENGLISH (PTE)  
Pearson Test of English is an English language test for students wishing to enrol in English-speaking universities.

POSTGRADUATE COURSES  
Students must normally have an undergraduate degree to begin studying any postgraduate course; this is sometimes known as graduate studies.

PREREQUISITE  
A topic that must be completed before a higher-level topic can be studied; it is the student’s responsibility to ensure that topic prerequisites have been met.

PRE-MASTERS PROGRAM  
A qualifying program for students who do not meet the entry requirements for a postgraduate masters degree.

SEASON  
The academic year is divided into two semesters -- usually late February to mid June, and late July to November.

STUDENT LEARNING CENTRE (SLC)  
The Student Learning Centre (SLC) is a multidisciplinary academic support service for Flinders University students.

TEST OF ENGLISH AS A FOREIGN LANGUAGE (TOEFL)  
A standardised test to measure the English language ability of non-native speakers wishing to enrol in English-speaking universities.

TOPIC  
A subject that is studied as part of a degree program.

TOPIC CODES  
Topic codes consist of a four-character alpha code followed by a four-digit code. These eight characters form the total topic code, eg EDUC1120 Teaching and Educational Contexts. These should be quoted whenever you are making an enquiry about enrolling in a topic.

UNDERGRADUATE DEGREE  
a first degree.

UNIT  
The measure of weighting given to a topic as specified in the syllabus for that topic. Each topic is given a weighting in units, roughly proportional to its length. Most full-time students complete 36 units a year to gain the 108 units needed to qualify for their degree if they are undertaking a three-year bachelor degree.

WORK INTEGRATED LEARNING (WIL)  
A program designed to give students the opportunity to link theory and practice with valuable workplace experience while studying.
USEFUL LINKS

These links may be useful as you plan your study at Flinders University and settle into life in Adelaide.

CONNECT WITH US:

DISCOVER FLINDERS:
FLINDERS LIVING:
flinders.edu.au/living
INTERNATIONAL CENTRE:
international.flinders.edu.au
INTERNATIONAL STUDENT SERVICES:
flinders.edu.au/international/services

LIFE IN ADELAIDE:
GETTING AROUND:
adelaidemetro.com.au
southaustralia.com/regions/adelaide-city-getting-here-around.aspx
MARKETS:
southaustralia.com/regions/adelaide-city-markets.aspx
SHOPPING:
southaustralia.com/regions/adelaide-city-shopping.aspx
EATING OUT AND ENTERTAINMENT:
southaustralia.com/DiningInAdelaide.aspx
ATTRACTIONS:
southaustralia.com/regions/adelaide-city-attractions.aspx

OTHER USEFUL LINKS:
DEPARTMENT OF IMMIGRATION AND BORDER PROTECTION:
immi.gov.au
ESOS FRAMEWORK:
aei.gov.au/Regulatory-Information
OVERSEAS STUDENT HEALTH COVER:
bupa.com.au/students
STUDY ADELAIDE:
studyadelaide.com

Disclaimer
The information contained in this publication is accurate at the time of publication: January 2017. Flinders University reserves the right to alter any course, topic or fees contained herein without prior notice.